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Introduction 

How to Use this Book 

Welcome to the RISA-2D User’s Guide. If you are a first-time user of RISA-2D, we recommend that you 

start with this book. This book contains step-by-step tutorials that guide you through the entire 

modeling process using most RISA-2D features. You will create a real-world example of building and 

solving a model, making changes, and optimizing the model. Several tips and shortcuts will also be 

demonstrated along the way.  

Begin by reviewing First Look at RISA-2D on page 9 to familiarize yourself with the RISA-2D menus, 

toolbars, and shortcuts. Then proceed to the step-by-step tutorials. There is also a handy reference 

included as Appendix A  – RISA-2D Toolbar Button Quick Reference to help you reference toolbar 

buttons. 

To complete all the tutorials will take only a few hours. However, you can speed up the process even 

further if you skip the supporting text and concentrate only on the action steps, which are indicated 

with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 

action steps while performing the tutorials. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 

one time, or performing each one separately. To make this possible, RISA provides model files for you to 

load at the beginning of each tutorial. These starter files are located in the RISA folder under Tutorials, 

and are named RISA-2D Tutorial 2 Starter.r2d, RISA-2D Tutorial 3 Starter.r2d, etc. 

After you have completed the tutorials in this guide, you can use the Help Menu and RISA-2D General 

Reference for complete, detailed information on every topic relating to RISA-2D. The topics are 

thoroughly indexed for quick reference.  

If you are a more experienced user and are not sure which book will be most helpful for your situation, 

consider that the RISA-2D User’s Guide covers how and when to apply RISA-2D features such as wall 

panels, but the specifics of how those wall panels are designed are covered in the Help Menu and the 

RISA-2D General Reference.  

Where to Download RISA-2D Book Updates 

Every effort has been made to ensure the accuracy of this book at the time of publication. The latest 

edition of all books and documents relating to this product are available in Adobe PDF format at 

http://www.risa.com. Click Downloads, Product Documentation, then RISA-2D. 
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Document Conventions 

The following conventions are used throughout this book: 

This convention: Indicates: 

CAPITAL LETTERS Names of keys on the keyboard – for example, SHIFT, CTRL, or ALT. 

KEY+KEY One key should be held down and then another key pressed – for 

example, CTRL+P or ALT+F4. 

Italic text New terms, other publications, and variable expressions – for example, 

filename.txt. 

Bold text 

Boxed text 

  

User interface options – for example, File menu. 

Notes or modeling tip information. 

Tutorial action item for building the model. 
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Using the Online Help 

Whether you need help on general topics, specific features, or toolbars, it is all built in to the extensive 

RISA-2D online Help system. The RISA-2D Help was designed to enable you to pinpoint the Help 

information you need quickly, by offering different ways for you to access and locate that Help, as 

described below: 

 

Help on  

general topics 
On the RISA toolbar, click the Help button . This is the fastest way to get help on general 

topics. You can also go to the main menu and click Help, then select Help Topics. 

Once you enter the Help, notice the three tabs on the left: Contents, Index, and Search. You 

can explore the Help by topic using either Contents or Index, or use Search to explore the 

Help with your own specific keywords. 

 

 

Help on a specific 

feature (context-

sensitive help) 

As you work, notice the Help buttons at the bottom of many of the dialog boxes. These 

provide direct access to the Help information related to the task you are performing.  

This context-sensitive help may be accessed by pressing the Help button on the dialog box or 

by pressing the F1 key. 

 

Help on toolbar 

buttons 

Are you uncertain what a toolbar button is for? Simply hold your mouse pointer over that 

button (without clicking), and a description of that button will be displayed.  
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Technical Support Information 

Technical support is an integral part of the software packages offered by RISA Technologies, and is 

available to all registered licensees at no additional charge. Our knowledgeable support team is ready to 

answer your most challenging questions.  

Before contacting technical support, you may want to take a few minutes to do the following: 

• Search the Help and all user documentation available for the product.  

• Search our FAQ database by visiting our website at http://www.risa.com. Click Education, 

then Frequently Asked Questions, then choose the product. 

When you are ready to make a support request, please be prepared to send us your model, and include 

the following information: 

• Your name, company name, and phone number;  

• Product name and serial number or Key ID;  

• A detailed problem description; and  

• Your model (filename.r3d) as an e-mail attachment. If your model contains multiple 

members, plates, or load combinations, please specify which ones we should look at.  

You can contact Technical Support by e-mail or phone as follows: 

E-mail: support@risa.com 

E-mail is usually the best way to communicate with us when sending a model. Please include all the 

information listed above. 

Phone: (949) 951-5815 or (800) 332-RISA (7472) 

Technical support personnel are available from 6:00 A.M. to 5:00 P.M. Pacific Standard Time, Monday 

through Friday.  

RISA Technologies Online 

Visit RISA Technologies online at http://www.risa.com for:  

• Answers to frequently asked questions. 

• Downloads of user documentation and tutorials. 

• Software updates – Any known problems are posted on the website, along with possible 

work-around procedures and/or service releases to update your software. 

• Software verification problems. 
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Before You Begin 

RISA-2D Overview 

RISA-2D was designed to accelerate the time it takes to perform structural design. Computer-aided 

structural design is typically a three step process: (1) define your model, (2) solve the model to obtain 

solution results, then (3) review those solution results to see how the model performed and determine if 

changes are needed. Usually, this cycle must be repeated several times before arriving at a final, 

optimized design.  

One main reason RISA-2D is able to speed up the design process so successfully is because of its unique 

ability to define the model and make revisions both graphically (using the drawing tools) and 

numerically (using the customized spreadsheets).  

In RISA-2D, these two methods of entering and editing data work seamlessly together. Everything 

designed or drawn graphically is automatically recorded in the spreadsheets (which may be viewed and 

edited at any time)—and everything entered in the spreadsheets may be viewed and edited graphically 

at any time. As you perform the step-by-step tutorials in this guide, you will be exploring both methods 

using the drawing tools and the spreadsheets. 

Hardware Requirements 

Minimum 

• Any Windows compatible computer with a Pentium 3 Processor or better  

• Windows XP/Vista/7/8.1/10 

• 256MB of RAM 

• 200MB of hard disk space 

• Two or three button mouse 

• USB port (required for Stand-Alone version or Network Host computer) 

Recommended 

• Windows 7/8.1/10 

• 256MB of RAM 

• 200MB of hard disk space 

• Two button mouse with wheel 
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Program Limits  

Joints 1,000 

Members 1,000 

Plates 1,000 

Materials 500 

Section Sets 500 

Custom Wood Species 500 

Basic Load Cases 1,000 

Loads 10,000 

Moving Loads 500 

Load Combinations 5,000 

Mode Shapes 2,000 

  

 

Demonstration Version:  While you can open and solve a larger model, the largest model that can be 

saved to disk with the demonstration version is limited to 20 Joints, 20 Members, 20 Plates and 1 wall 

panel. 

Also, the Demonstration Version will automatically shut down if left open for 24 continuous hours. 
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License Agreement 
END-USER LICENSE AGREEMENT FOR RISA TECHNOLOGIES, INC. SOFTWARE 

The RISA-2D software product (SOFTWARE PRODUCT) includes computer software, the associated 
media, any printed materials, and any electronic documentation. By installing, copying or otherwise 
using the SOFTWARE PRODUCT, you agree to be bound by the terms of this agreement. If you do not 
agree with the terms of this agreement RISA Technologies, Inc. is unwilling to license the SOFTWARE 
PRODUCT to you. In such event you must delete any installations and destroy any copies of the 
SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA Technologies, Inc. within 60 days of 
purchase for a full refund.  

Copyright © 2022 by RISA Tech, Inc. All rights reserved. RISA is part of the Nemetschek Group. The 
SOFTWARE PRODUCT is protected by United States copyright laws and various international treaties. All 
rights not specifically granted under this agreement are reserved by RISA Tech, Inc. “RISA” as applied to 
structural engineering software is a registered trademark of RISA Tech, Inc.  

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and 
remains vested in RISA Technologies, Inc. You may not rent, lease, or lend the SOFTWARE PRODUCT. You 
are specifically granted a license to the use of this program on no more than one CPU at any given time. 
The Network Version of the SOFTWARE PRODUCT is licensed for simultaneous use on a certain 
maximum number of network stations that varies on a per license basis. As part of the license to use the 
SOFTWARE PRODUCT, the program user acknowledges the reading, understanding and acceptance of all 
terms of this agreement. The SOFTWARE PRODUCT may not be reviewed, compared or evaluated in any 
manner in any publication without expressed written consent of RISA Technologies, Inc. You may not 
disassemble, decompile, reverse engineer or modify in any way the SOFTWARE PRODUCT. If the 
SOFTWARE PRODUCT was purchased at a discounted price for educational purposes it may in no event 
be used for professional design purposes. The terms of this license agreement are binding in perpetuity.  

2. DISCLAIMER. We intend that the information contained in the SOFTWARE PRODUCT be accurate and 
reliable, but it is entirely the responsibility of the program user to verify the accuracy and applicability 
of any results obtained from the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by 
professional engineers and architects who possess an understanding of structural mechanics. In no 
event will RISA Technologies, Inc. or its officers be liable to anyone for any damages, including any lost 
profits, lost savings or lost data. In no event will RISA Technologies, Inc. or its officers be liable for 
incidental, special, punitive or consequential damages or professional malpractice arising out of or in 
connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies, Inc. or its officers 
have been advised of or should be aware of the possibility of such damages. RISA TECHNOLOGIES’ entire 
liability shall be limited to the purchase price of the SOFTWARE PRODUCT.  

3. LIMITED WARRANTY. RISA Technologies, Inc. warrants that the SOFTWARE PRODUCT will operate but 
does not warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA 
Technologies sole obligation and your exclusive remedy under this warranty will be to receive software 
support from RISA Technologies via telephone, email or fax. RISA Technologies shall only be obligated to 
provide support for the most recent version of the SOFTWARE PRODUCT. If your version of the 
SOFTWARE PRODUCT is not the most recent version RISA Technologies shall have no obligation to 
provide support in any form. Except as stated above the SOFTWARE PRODUCT is provided without 
warranty, express or implied, including without limitation the implied warranties of merchantability and 
fitness for a particular purpose.  
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4. PROTECTION DEVICE. In the event the SOFTWARE PRODUCT requires the use of a PROTECTION 

DEVICE to operate, you are specifically prohibited from attempting to bypass the functionality of the 

PROTECTION DEVICE by any means. A lost or stolen PROTECTION DEVICE will not be replaced by RISA 

TECHNOLOGIES.  

5. TERMINATION. RISA TECHNOLOGIES may terminate your right to use the SOFTWARE PRODUCT if you 

fail to comply with the terms and conditions of this agreement. In such event you must delete any 

installations and destroy any copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE 

PRODUCT to RISA Technologies.  

6. CHOICE OF LAW. By entering into this Agreement in accordance with Paragraph 1, above, you have 

agreed to the exclusive juris- diction of the State and Federal courts of the State of California, USA for 

resolution of any dispute you have all relating to the SOFTWARE PRODUCT or related goods and services 

provided by RISA Technologies. All disputes therefore shall be resolved in accordance with the laws of 

the State of California, USA and parties to this Agreement expressly agree to exclusive jurisdiction within 

the State of California, USA. No choice of law rules of any jurisdiction apply.  

Installation 

Installation Instructions 

To install RISA-2D, please follow these instructions: 

• Contact RISA Technologies licensing department (license@risa.com) for a program installation 

link. 

• Click on the link from the email that they will send you. 

• Follow the on-screen instructions. 

RISA-2D Customization–Important Assumption! 

Please ensure that when performing these tutorials, RISA-2D has not been customized in any way, and is 

in the default, installed state. If the installation of RISA-2D has been customized, you may reset the 

program defaults as follows: on the Tools menu, click Reset All Program Defaults. 

Maintenance 

Program maintenance provides all upgrades to RISA-2D, discounts on new products, and top priority for 

technical support. 

When your maintenance expires, you will be given the opportunity to continue program maintenance 

on an annual basis. You are under no obligation to continue program maintenance, of course, but if you 

decide to discontinue maintenance you will no longer receive RISA-2D program upgrades and you will 

not be eligible for technical support once the version of the program you ended with becomes obsolete. 
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First Look at RISA-2D 

Starting RISA-2D 

This section describes the RISA-2D user interface, the toolbars, and shortcuts. We recommend that you 

review this section before you begin the tutorials. 

Start RISA-2D as follows: 

 On the Start button, click All Programs, select RISA, then select RISA-2D. 

Windows and Dialog Boxes 

When you first start up RISA-2D, you will be presented with the following screen: 

 
  

Minimize  Maximize  Close 

Status Bar 

Starting a 

Model dialog 

box 

Workspace 
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Title bar The title bar at the top of your RISA-2D window can be very useful. Besides containing the 

name of the file that is currently open, it can also be used to move the window and 

minimize, maximize, and resize the window. 

 

To move the window, press and hold the title bar with your mouse, then drag to the 

desired location.  

Minimize, 

Maximize, 

Close 

The three buttons  on the right of the title bar control the RISA-2D window as 

follows: 

• Click Minimize   to minimize the window to a button on the taskbar. 

• Click Maximize  to maximize the window to full screen. Once it is full screen, 

click Restore Down  to restore the window down to its original size. 

• Click Close  to close the window. 

Workspace The actual work that you do in RISA-2D will be in the main area on the screen, the 

workspace. Currently the workspace is empty except for the Starting a New Model dialog 

box. As you create new model views and spreadsheets they will also appear in the 

workspace.  

Status bar The Status bar at the bottom of your screen will report information about your model as 

you work. 

 If the letter “S” is dimmed, a solution has not been performed. After a solution has been 

performed, the letter “S” will become blue in color with a red checkmark (as shown below). 

If the “S” is yellow, this means you have solution results but there have been modifications 

via the Member Redesign dialog box. 

 

To the right of the “S” are 3 status boxes: 

• The first status box displays general information relative to the task you are 

performing. 

• The second (middle) status box reports the units of the current spreadsheet cell. 

As you move from cell to cell, look to the middle status box for the appropriate 

units. This box is empty if you are not working in a spreadsheet. 

• The third status box (on the far right) reports the cursor coordinates as you work 

in the model view. This will be demonstrated throughout the tutorial. 

Dialog 

boxes 

Dialog boxes are windows that help you perform a specific function within RISA-2D. For 

example, the Starting a Model dialog box is presented when you first open RISA-2D, which 

helps you find the file you wish to open.  
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Menus and Toolbars 

Main Menu 

 

The Main menu and its submenus provide access to all features RISA-2D has to offer, as summarized 

below: 

File Provides access to file operations such as opening, saving, and exporting files. 

Edit Provides editing tools that help you modify and manipulate the spreadsheets. 

You may use this menu to add or remove information from the spreadsheets 

or to sort and mathematically manipulate current spreadsheet data. 

Settings Provides access to the (Global) Model Settings dialog box which may be used 

to modify global solution and design settings. 

Units Allows you to set units or convert existing units. 

View Allows you to open a new model view or adjust the current model view. 

Insert Used to insert drawing grids, slabs, beams, footings, and loads into the model. 

All of these items may be drawn graphically or entered in the spreadsheets. 

This menu provides access to the graphical methods that RISA-2D provides, 

while the Spreadsheets menu gives you access to the spreadsheets. 

Modify Allows access to the graphic editing features and may be used to modify 

existing model elements. 

Spreadsheets Opens the spreadsheets. 

Solve Solves the model. 

Results Allows access to all analysis result spreadsheets. This button is dimmed when 

no results are available, such as before you run a solution. 

Tools Provides tools to help you organize, identify, and correct problems as you 

model the structure. Program Application Settings are also located here. 

Window  Manages all of the windows that you have open in RISA-2D, whether they are 

spreadsheets or model views. Special tiling options are also available that 

relate to specific modeling tasks. 

Help Provides access to the RISA-2D online Help menu. For more information on 

Help, see Using the Online Help on page 3. 
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Toolbars 

The most commonly used features available on the Main menu are also available on the toolbars as 

toolbar buttons. The toolbars are designed to speed up your workflow by placing these tools close to 

your workspace and making them easily visible.  

Unlike some of the other toolbars, the RISA toolbar never changes.The other toolbars change, 

depending on whether you are in model (graphical) view or spreadsheet view. 

 

 

If you are not sure what a particular toolbar button does, simply position your mouse over the button 

and a short definition will display. 

Note:  You will discover many methods of accessing the tools available in RISA-2D. The methods you 

choose—whether menus, toolbars, or keyboard shortcuts—will simply be a matter of personal 

preference. 

Window toolbar – any time a 

spreadsheet is open, notice 

the window toolbar changes 

Selection toolbar - 

is not visible in 

spreadsheet view 

In Spreadsheet View 

Window toolbar  

(in Model View) – contains 

viewing commands 

Data Entry toolbar - provides quick 

access to spreadsheets (then toolbars 

switch to spreadsheet view) 

-AND/OR-   

Results toolbar - After the model is 

solved, the results are displayed here 

RISA toolbar – provides access to file operations, 

printing, changing design parameters, etc. 

Drawing toolbar -  

Toggle on with (CTRL+G) 

Selection toolbar – 

provides tools to help 

make model selections 

Main menu 

In Model View 
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RISA Toolbar  

 

The RISA toolbar is located directly below the Main menu. Unlike some of the other toolbars, the RISA 

toolbar never changes. These buttons perform general actions such as opening and closing files, 

changing design parameters, printing, and solving the model.  

Window Toolbar  

…in Model View 

 

The Window toolbar is located directly below the RISA toolbar. When working in a graphic model view, 

the buttons provide model viewing tools, such as rotate and zoom, and others. 

…in Spreadsheet View 

 

When you are working in a spreadsheet, this toolbar provides spreadsheet editing tools, such as Sort, 

Block Fill and Block Math. 

Drawing Toolbar  

 

The Drawing toolbar provides tools to assist with creating and modifying your model graphically. This 

toolbar may be turned on and off (CTRL+G) as needed. 

Selection Toolbar  

…only visible in Model View 

 

The Selection toolbar is the vertical toolbar along the left side of the screen.  

It provides tools to help you select and unselect parts of the model.  

You will need to make selections when you do things like graphically edit a  

part of the model or print only part of the results.  
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Spreadsheet Toolbars  

(Data Entry and Results Toolbars)  

These two toolbars provide access to the spreadsheets. You 

can turn them on and off on the RISA toolbar by clicking the 

Data Entry button  or the Results button . 

The Data Entry toolbar is a vertical toolbar on the right of 

your screen. It looks different than the other toolbars 

because its buttons consist of text instead of images.  

The Results toolbar is very similar. It appears after the 

model has been solved and provides quick access to the 

results spreadsheets. 

Both toolbars allow you to access the spreadsheets very 

quickly while building and solving your model. The buttons 

appear in the general order as you may need them.  

  



 First Look at RISA-2D 

 15 

Managing Windows, Model Views, and Spreadsheets 

Managing Windows 

As you work in RISA-2D, you will be working within model views and spreadsheets, each in their own 

window that may be moved around the workspace and resized as you wish. A powerful feature of RISA-

2D is the ability to have multiple model views and spreadsheets open at one time. The Window menu 

provides many options to help manage the display of these windows. 

 

Managing Model Views 

You may open as many model view windows as you like. This is especially helpful when working zoomed 

in on large models. You might have one overall view and a few views zoomed in and rotated to where 

you are currently working. You may have different information plotted in each view. 

Remember that the toolbars displayed by RISA-2D vary depending on which window is active (the 

window with a colored title bar is the active window).  

For example, if your active window is a 

spreadsheet, and you are looking for the 

zoom toolbar, you will not be able to 

locate it until you click your model, 

switching to model view. Then you will 

be able to access the zooming tools, and 

all the other tools related to modeling. 

  

Scroll bar - to view information 

outside of the window’s viewing 

area, click the scroll arrows or drag 

the scroll bar to move the display one 

way or the other. 

Scroll  

arrows & 

scroll bar 

Minimize,  

Maximize, and  

Close buttons 
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Working in Spreadsheets 

Spreadsheets are comprised of rows and columns of data cells. To add or edit data in a cell, click the cell, 

making it the active cell, then type. Only one cell can be active at a time, and it is denoted in green. You 

can change which cell is active using the LEFT ARROW, RIGHT ARROW, PAGE UP, PAGE DOWN, HOME 

keys, etc. 

You may also select blocks of cells to work on. To select a block of cells, click and hold the mouse button 

in the first cell in the block, drag to the last cell in the block, then release the mouse. To select an entire 

row or column, simply click the row or column label. To select multiple rows or columns, click and drag 

the mouse across multiple row or column buttons. 

 

 

Column label – Click 

the column label to 

select the entire 

column 

Scroll bar 

Row of cells – Click the 

row label (at left) to 

select the entire row 

Column of cells 

Click any cell. Notice the Status 

Bar displays an explanation of the 

current column. 
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Tutorial 1 – Modeling 

Overview 

The four tutorials contained in this User’s Guide are designed to help you explore both the spreadsheet 

and graphic drawing capabilities of RISA-2D. The tutorials demonstrate not only how you build your 

model, but also how you make changes to the model to make it more efficient, or when design 

modifications become necessary. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 

one time, or performing each one separately. To make this possible, RISA provides model files for you to 

load at the beginning of each tutorial. These starter files are located in the RISA program folder under 

Tutorials, and are named RISA-2D Tutorial 2 starter.r2d, RISA-2D Tutorial 3 starter.r2d, etc. 

In Tutorial 1, you will create a frame comprised of two steel columns supporting a wood truss. In 

Tutorial 2, you will copy the frame into a 2-bay model and make modifications. Tutorial 3 will 

demonstrate how to define loads in the model. Tutorial 4 will illustrate how to run static solutions and 

review the results. When you finish all four tutorials, the final product will look like this: 

 

To complete all four tutorials will take only a few hours. However, you can speed up the process even 

further if you skip the supporting text and concentrate only on the action steps, which are indicated 

with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 

action steps while performing the tutorials. 
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Starting a New File 

When you are ready to begin, start RISA-2D if you have not already done so: 

 Double-click the RISA-2D icon to start the program. The Starting a Model dialog box will display, 

which allows you to create a new model or open an existing file.  

 

You have several startup options, along with a blank drawing grid placed in the workspace. You can 

choose to start drawing your model (either by defining members, or using a template to generate it 

automatically); you can open an existing model; or you can click Close  to work on your own.  

Automatically Generating with Templates 

RISA-2D has powerful templates that automate the generation of structures. Although you will not be 

using them for the tutorials, it is helpful to know a bit about them for future use. You may access these 

templates two ways: (1) on the Starting a Model dialog box, select  Click here to use a template to 

generate a model; or, (2) on the Insert menu, click Structure(Generate). 

Some of the templates are very specific (such as the Parabolic Arc template), while others are general 

(such as the Circular Disk With Plates). Using these templates, you can generate almost any typical or 

repetitive model or model component.  

Once you complete the tutorials and learn how to build structures without the templates, you will be 

able to more easily understand how and when to use templates. This will speed up your day-to-day 

workflow and make RISA-2D even more powerful. 

  

Note: The appearance of your 

menus and toolbars may look 

slightly different, depending on 

your computer screen resolution 

and font sizes. 
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Start Modeling 

Begin creating your model by drawing members: 

 Under Create a New Model, select the Open the (Global) Model Settings window also check 

box. This will save you a step by opening the (Global) Model Settings dialog box after you make 

your starting selection. 

 Select  Click here to immediately start drawing members. 

Because you selected the Open (Global) Model Settings check box option, the (Global) Model Settings 

dialog box opens first.  

(Global) Model Settings 

This dialog box provides access to global settings that apply to the model as a whole. 

Set the (Global) Model Settings as follows: 

 Type a model title, company name, and your name, as shown below.  

 Click Apply. The dialog box will remain open. 

The (Global) Model Settings dialog box: 

 

Review and modify the Solution parameters: 

 In the (Global) Model Settings dialog box, click the Solution tab.  

 In the Number of Sections box, type 7 (or you may use the up/down arrows to 

increase/decrease the value).  

 Click Apply. 

  

(Global) Model Settings 

are settings that apply to 

the entire model. 

Tip: Press TAB to advance to 

the next field. 

Type any notes you would 

like to keep with the model 

in the Notes box. 
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The dialog box will remain open, and should now look like this: 

 

Below is a description of all the available solution parameters: 

Number of 

Sections 

Specify how many locations along each member are to be used for the reporting 

of forces, stresses, and deflections.  

INTERNAL Sections Controls how many places along each member RISA-2D calculates and stores 

results, such as deflections and code checks. The member force diagrams 

displayed in the model view and the detail plot are also drawn from these 

results. 

Shear Deformation This check box indicates whether or not shear deformation considerations are 

to be included in the model solution.  

Wall Mesh Size Defines the base wall panel mesh size. 

Include P-Delta for 

Walls 

This is used to enable P-Delta analysis for wall panels.  Note that this will only be 

performed on load combinations that have P-Delta included.  

Increase Nailing 

Capacity for Wind 

Selecting this option will automatically increase the shear capacity of wood wall 

and diaphragm panels by 1.4 for all wind load load combinations.  Note that 

load combinations with both seismic and wind loads will not receive this 

increase. 

Wall Design This selection indicates whether or not you want your wall panel design to be 

optimized. 

Iterations This designates the number of iterations that the wall design feature will go 

through for the wall optimization. 
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Review the options for the Code parameters: 

 In the (Global) Model Settings dialog box, click the Codes tab.  

For this tutorial, the default settings will be used. 

 

These settings control how code checking is performed, as described below:  

Hot Rolled 

Steel 

Code choices include AISC 15th (360-16) ASD & LRFD, 14th(360-10) ASD & LRFD, 13th (360-

05) ASD & LRFD, 9th Edition ASD, 2nd Edition LRFD, 3rd Edition LRFD, and several 

international steel codes. If the AISC 360 code is selected, the Adjust Stiffness menu will 

appear. The options in this menu control the stiffness reduction provisions per App. 7 of 

the code. 

Cold Formed 

Steel 

Code choices are AISI S100-16 (ASD&LRFD), AISI S100-12 (ASD&LRFD), AISI S100-10 

(ASD&LRFD), AISI S100-07 (ASD&LRFD), AISI NAS-04 (ASD&LRFD), AISI NAS-01 

(ASD&LRFD), AISI 99 (ASD & LRFD), and several international codes. If the AISI S100-16 

code is selected, the Adjust Stiffness menu will appear. The options in this menu 

control the stiffness reduction provisions of the code. 

Concrete Code choices include the 99, 02, 05, 08, 11, & 14 Editions of ACI along with several 

international codes. 

Wood Code choices include the 97, 01, 05/08, 12, 15 & 18 Editions of the NDS. 

Wood 

Temperature 

This selection is used to calculate the temperature factor (Ct) used in the design of 

wood members. 

Masonry Code choices include TMS 402-16 (ASD & Strength), ACI 530-13 (ASD & Strength), ACI 

530-11 (ASD & Strength), ACI 530-08 (ASD & Strength), ACI 530-05 (ASD & Strength), ACI 

530-02 (ASD & Strength) along with several international codes. 

Aluminum Code choices include AA ADM1-15 ASD (ASD&LRFD Building & ASD Bridge) , AA ADM1-

10 ASD (ASD&LRFD Building & ASD Bridge), and AA ADM1-05 ASD (Building & Bridge). 



Tutorial 1 – Modeling 

22 

Adjust Stiffness Determines whether or not the stiffness adjustments per AA ADM1 are applied to your 

members. 

Stainless Code choices include the AISC 14th (360-10) ASD & LRFD. The options in the Adjust 

Stiffness menu control the stiffness reduction provisions of the code. 

 

Review and modify the options for the Concrete parameters: 

 In the (Global) Model Settings dialog box, click the Concrete tab.  

 Under Concrete Stress Options, click Parabolic Stress Block. This method is the more accurate 

of the two methods. 

 Click Apply. 

 

These settings contain options related to the analysis and design of concrete members as described 

below:  

Shear Tie Options Allows you to control the number of shear regions that will be used when 

detailing a beam or column span. It also allows you to specify an increment when 

increasing or reducing the spacing of the shear ties. 

Concrete Stress 

Options 

Allows you to choose what type of stress block to consider in your analysis. The 

options are the constant Rectangular Stress Block and the Parabolic Stress 

Block.  

Concrete check 

boxes 

Use Cracked Sections - modifies the member stiffnesses by the Icr Factor. For 

more information, refer to RISA-2D General Reference.  

Bad Framing Warnings - helps you detect modeling errors during solution. It 

produces a message in the error log whenever an unsupported member is 

detected at either of its end joints (can be common for models that contain 

cantilevers, rafters, etc.)  

Unused Force Warnings - produces messages on the member detail report when 

weak axis and torsional moments have been neglected. 

Click Save As Defaults any time to save all 

current settings to become the new default 

settings for all future models. 

Click the Help button to open 

the Help Menu to the relavent 

topic. 
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Minimum 1 Bar Dia Spacing - allows a minimum spacing of one bar diameter 

between parallel bars. Otherwise, RISA-2D will default to a two bar diameter or 

one inch clear spacing, whichever is greater, to allow for lap splices and continue 

to maintain adequate spacing between parallel bars. 

Concrete Rebar 

Set 

Allows you to specify the grade of rebar you wish to use. You can also specify a 

Minimum % Steel and Maximum % Steel for column reinforcement. 

 

Before closing the (Global) Model Settings dialog box, notice you will also see a tab labeled Footings. If 

you have RISAFoot installed, this will allow you control over footing design input. If you do not have 

RISAFoot installed, this tab will only state that you need to install the program in order to utilize the 

integration. For more information on this integration, please click Help or refer to RISA-2D General 

Reference Manual. 

You may now close the (Global) Model Settings dialog box. 

 Click OK to exit.  

Members 

Once you close the (Global) Model Settings dialog box, the Draw Members dialog box will display: 

 

Before drawing the members, first define the material type to be used, either: Hot Rolled, Cold Formed, 

Wood, Concrete, Aluminum, Stainless or General. Once the materials are stored in RISA-2D, the 

spreadsheets and solution results will be sorted based on that material. When performing a solution, 

RISA-2D will only analyze and/or design members for load combinations that are appropriate for that 

material (this will be discussed in more detail in Tutorial 3 – Loading). 
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Define Hot Rolled Steel as the material type for the new members you will be creating: 

 Under Member Material Type and Shape, click Hot Rolled. 

Next, you need to decide how you want to define the cross-sectional properties of the member. You can 

assign a shape directly, or define your properties based on section sets.  

For now, start with a 12x53 column, and assign your concrete shapes directly. (Later you will use section 

sets for your wood truss and concrete members.) 

 Click Assign Shape Directly.  

This bypasses the section sets and allows you to assign an explicit shape for these new members: 

 Under Start Shape, highlight and type W12x53. 

 Under Type, select Column. 

 Under Design List, select Wide Flange. 

 Under Material, select A992. 

The dialog box should now look like this: 

 

Verify the settings, then prepare to start drawing: 

 Click Apply. 

Note: After you click Apply, your cursor changes to , indicating that you are now in the drawing 

mode. Also notice that on the Drawing toolbar, the Draw New Members  button is pressed in. 

The release codes are used to 

designate whether the forces 

and moments at the ends of the 

member are considered fixed to 

or released from the member's 

points of attachment (the end 

joints). 
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Drawing Grid 

Before you begin drawing, notice that RISA-2D will always open a default 30x30 grid spaced at one foot. 

To make it easier to find your column and beam locations for this tutorial, redefine the grid as follows: 

 On the Drawing toolbar, click the Modify Drawing Grid  button to redefine the grid. The 

Drawing Grid tab should already be selected. 

Change the grid increments as follows:  

 Under Rectangular Grid Increments, in the first column under X Axis, highlight and delete any 

current data and type: 3,4@3.75,3 (including the commas).  

 In the first column under Y Axis, highlight and delete any current data and type: 10,8.5,4 

(including the commas). 

The dialog box should now look like this: 

 

Close the Drawing Grids dialog box and the Data Entry toolbar. 

 Click OK to close the dialog box.  

 Click Close  to close the Data Entry toolbar (upper right corner of your workspace). 

  

These settings define a drawing grid with an initial 

X-increment for the truss points of 3 ft, followed by 

4 equal increments of 3.75 ft each (denoted by the 

“@” symbol), and a final increment of 3 ft.  

Other options available: you may specify a 

radial grid, you may save the grid layout to 

use in other models, and you may make this 

the default grid layout. 
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Drawing Members 

As you move your cursor around the drawing grid (specifically over grid intersections), notice RISA-2D 

displays the coordinate location of the cursor in the lower right corner of the Status bar. 

 

The coordinates displayed on the Status bar are the coordinates of the grid point or joint location closest 

to the cursor. Notice the coordinates change as you move the mouse around. Also, when you are in the 

drawing mode (as you are now), the points are highlighted by a red dot any time the tip of your mouse 

approaches the point.  

 

Start by drawing a line from point A to point B, as shown in the image above: 

 Place the cursor on the lower left corner of the grid to create point A (coordinates 0,0) and click 

once. (Notice a joint has been created and labeled N1.) 

 Next, move the mouse straight up to point B (coordinates 0,18.5) and click again. (Another joint 

has been created and labeled N2.) 

Note: After drawing a member, your cursor remains linked until you either draw another member or 

terminate drawing. To terminate drawing, right-click the mouse or press ESC.  

  

Grid Locations: 

Point A (0,0) 

Point B (0,18.5) 

As you continue the tutorial, 

ensure that you draw the 

members in the specified 

location by watching the 

Status bar to verify the exact 

coordinate location. 

Status bar 
Coordinates of the current grid 

intersection location of the mouse 
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Your screen should now look like this: 

 

 When finished drawing the line, right-click to release the mouse. 

 

Draw another line from point A to point B, as shown in the image above: 

 To create point A, place the cursor on the lower right corner of the grid (coordinates 21,0) and 

click once. (The new joint has been created and labeled N3.) 

 Next, move the mouse straight up to point B (coordinates 21,18.5) and click again. (The new 

joint has been created and labeled N4.) 

 When finished drawing the line, right-click to release the mouse. Right-click a second time to 

exit the drawing mode. 

  

Grid locations: 

Point A (21,0) 

Point B (21,18.5) 

To release the mouse: 

Right-click the mouse or 

press ESC when finished 

drawing. 

To undo any mistakes:  

Press the Undo button or 

CTRL+Z. 
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Now you should have a column on the left, extending from joint N1 to joint N2, and another on the 

right, from joint N3 to N4. 

Before drawing the truss, take a moment to change the way that members are shown and color-code 

them by their section sets. 

 On the Window toolbar, click Model Display Options . 

The Model Display Options will be discussed in more detail later. For now, just change the color coding: 

 In the dialog box, click the Members tab. 

 Click Color Coded. Under Color Basis, select Section Set. Under Labeling, select No Labeling. 

Now the dialog box looks like this: 

 

These settings will color code the members by their section sets. Close the dialog box and return to your 

model: 

 Click OK. 
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The members should now be displayed in color and a legend is now displayed in the upper right corner 

of the workspace. Notice that the description appears in the legend as “na” because the section sets 

have not yet been defined. 

 

Now that the columns are defined, move ahead to the truss members. To resume drawing: 

 On the Drawing toolbar, click the Draw New Members button .  

You will now define your truss members as you would a section set. This allows you to group similar 

members for easier modeling and modifying. Because you have not yet defined any section sets, you will 

first place the members in the sets as you build the model, then define the properties (section sets) 

later. 

 Under Member Material Type and Shape, click Wood. 

 Then click Assign a Section Set to assign a section set for your new members. (The available 

options for Wood will appear.) 

The dialog box should now look like this: 
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Return to the model view and resume drawing: 

 Click Apply. 

 

Using the grid locations shown above, draw the truss chord: 

 Draw members from points A to B, then B to C, then C to D, and lastly from D to A.  

 Right-click the mouse or press ESC two times to release the mouse and exit the drawing mode. 

Next, you will draw the web members using the section set again. Later, you will modify this to 

differentiate the web members from the truss chords using separate section sets. Another way to get 

back to the Member Properties dialog box is to use the shortcut menu: 

 Right-click the mouse (from anywhere in your workspace) to activate the Shortcut menu. 

 

To activate the Shortcut 

menu, right-click the 

mouse from anywhere on 

the workspace. 

Note: Because the truss chords were 

defined as a section set, they will 

display in a different color than the 

columns. 

Grid Locations: 

Point A (0,18.5) 

Point B (21,18.5) 

Point C (18,22.5) 

Point D (3,22.5) 
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The shortcut menu displays options available that relate to the tasks you are performing. These options 

are specific to your current view. For example, if you were viewing a spreadsheet, the choices would be 

relevant to spreadsheets. 

Next, recall the Draw Members dialog box and redefine the web members to be pinned at both ends: 

 On the shortcut menu, click Recall Last Dialog to display the Draw Members dialog box again. 

 Under Release Codes, click Pinned at Both Ends. 

The dialog box should now look like this: 

 

Exit the dialog box: 

 Click Apply. 
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Using the grid locations shown above, draw the web members: 

 Draw members from points A to B, B to C, C to D, D to E, then E to F.  

 Right-click the mouse or press ESC to release the mouse. 

Use a new starting point for the next series of members. 

 

Use the grid locations shown above to draw the next series of members: 

 Draw members from points A to B, B to C, C to D, then D to E.  

 Click the right mouse button or press ESC to release the mouse. 

  

Grid Locations: 

Point A (3,22.5) 

Point B (3,18.5) 

Point C (6.75,22.5) 

Point D (6.75,18.5) 

Point E (10.5,22.5) 

Point F (10.5,18.5) 

Grid Locations: 

Point A (18,22.5) 

Point B (18,18.5) 

Point C (14.25,22.5) 

Point D (14.25,18.5) 

Point E (10.5,22.5) 
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Your model should now look like this: 

 

Physical Members 

Notice that you have defined your truss chords with one member, rather than multiple members 

between each joint. RISA-2D’s Physical Member feature allows you to quickly draw in members this way, 

rather than making you draw every member as split between nodes. 

Physical Members automatically connect the members and nodes that frame into them along their 

midspan. Therefore, you do not have to use multiple members to model what is one Physical Member in 

the field. Therefore, if you later have to make changes to your model, you do not have to apply changes 

to multiple smaller members. Most important, the results values for this continuous member will not be 

spread out over multiple members, making it difficult to find design values--it will instead be presented 

as that of only one member.  
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Material Properties 

RISA-2D provides default section sets for each basic material type. Later, you will create some additional 

section sets using the Section Sets spreadsheet. You will then define the section properties for all the 

truss members that you have defined so far.  

Using the Materials spreadsheet, review your material properties. 

 On the RISA toolbar, click the Data Entry toolbar  button to display the Data Entry toolbar. 

 On the Data Entry toolbar, click Materials. 

The Materials spreadsheet will display: 

 

Note: The United States default material values are built in to RISA-2D. However, you can create new 

default values for your future models by adding those materials into any spreadsheet and, on the 

Window toolbar, by clicking Save as Defaults .  

For example, if you are working on a Canadian job with a steel that conforms to the G40.21 specification, 

you can add that material and save it for use on future models. On the Window toolbar, click Save as 

Defaults . Any new models will start with this steel material automatically. 

  

Notice the tabs contain the 

various material types. Click to 

review the information under 

each tab. 

When you click any cell, notice the 

Status bar (bottom of the screen) 

gives an explanation of the current 

column. 
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Wood Properties 

Next, modify the wood material for the truss members. The complete NDS species database is built into 

RISA-2D. Therefore, when defining the wood properties, you can select any valid species/grade 

combination, and RISA-2D will provide the design values.  

Modify the grade of wood to be used: 

 On the Materials dialog box, click the Wood tab. 

 Go to the bottom of the spreadsheet and press ENTER. 

 Type DFL Select as the Label. 

 Press the TAB key three times. 

The active (green) cell should now be in the Species column. 

 Click in the Species menu. Review the list of available speciess by dragging the scroll bar up and 

down. 

 Select Douglas-Fir Larch. 

 

 Press the TAB key once to advance one column to the right. 

The active (green) cell should now be in the Grade column. 

 Click in the Grade menu. Review the list of available grades by dragging the scroll bar up and 

down. 

 Click Select Structural. 

Note: In the future, you may save any changes for future default values for new models by clicking the 

Save as Defaults  button. This button is located on the Window toolbar. 

Now that you have defined the material properties, you will use them to define the members and 

section sets. 
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Design Rules – Size/UC  

In an effort to optimize hot rolled, cold formed, wood, concrete, aluminum, and masonry members, 

RISA-2D will suggest a lighter, more efficient shape for each of the members. When suggesting an 

alternate shape, RISA-2D will only consider shapes that are included in the designated Design List. The 

Design List is a set of members that will be used in the design and optimization of a member.  

For example, a section set could be defined with the Wide Flange Design List. This list references the 

redesign list which contains the US list of Wide Flange sections from the AISC Manual of Steel 

Construction. In this case, RISA-2D will never suggest that a Channel or H Pile would be a more efficient 

shape. For information about editing the existing Design Lists or creating your own custom Design Lists, 

refer to RISA-2D General Reference. 

You may edit the default redesign lists at any time to create custom lists of your own. These lists are 

contained in C:\RISA\risa_redesign_lists and you may open/edit them in a text formatting program, such 

as Notepad. 
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Next, using the Design Rules spreadsheet, specify some additional restrictions as to what type of 

sections RISA-2D can select for redesign: 

 On the Data Entry toolbar, click Member Design Rules. 

The Design Rules spreadsheet will display: 

 

Enter the following data in row 1: 

 In row 1, under Label, type Col-Rules. (Press the TAB key two times.) 

 Under Min Depth, type 12. (Press the TAB key two times.) 

 Under Min Width, type 10. 

 Press ENTER. 

Enter the following data in row 2 (continue pressing the TAB key to advance between columns): 

 In row 2, under Label, type Steel-Bms. 

 Under Min Depth, type 12.  

 Press ENTER. 

Enter the following data in row 3: 

 In row 3, under Label, type Conc-Bms. 

 Under Min Depth, type 12.  

 Under Min Width, type 10. 

 Press ENTER. 

Enter the following data in row 4: 

 In row 4, under Label, type Truss-Rules. 

 Under Max Depth, type 10.  

 Under Min Depth, type 3.5.  

 Under Max Width, type 6.  

 Under Min Width, type 1.5. 

 Press ENTER. 

Enter the following data in row 5: 

 In row 5, under Label, type Alum-Rules. 

 Under Max Depth, type 6.  

 Under Max Width, type 6.   
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When finished, the spreadsheet should look like this: 

 

Notice there are several parameters available to control the suggested alternate shapes. You can define 

acceptable member depth and width ranges, and also code check ranges. 

Design Rules – Concrete Rebar  

In addition to controlling the size of your concrete members, RISA-2D also allows you to control the type 

of reinforcement and cover to be used.  

 On the Design Size and Code Check Parameters spreadsheet, click the Concrete Rebar tab. 

This spreadsheet controls the size and placement of the flexural and shear reinforcement used in the 

design of your concrete beams and columns.  

Change the minimum bar size for Col-Rules: 

 In row 1 (labeled Col-Rules), click the first cell in the Min Flex Bar column. Click a second time in 

the cell to reveal the list of options, and select #6.  

Note: It may be helpful to lengthen the column heading to read the full column label. 

Change the maximum bar size for Conc-Bms: 

 In row 3 (labeled Conc-Bms), click the cell in the Max Flex Bar column. Click a second time in the 

cell to reveal the list of options, and select #9.  

 

Note: Although rules for concrete rebar are given for each Design Rule that you have created, these 

rebar entries will be ignored if they are applied to anything other than concrete members. 
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Section Sets Spreadsheet 

RISA-2D provides default section sets for each basic material type. You will now use this spreadsheet to 

define your new section sets. While in this spreadsheet, you will also define the section properties for 

the members you have defined so far.  

Open the Section Sets spreadsheet. 

 On the Data Entry toolbar, click Section Sets. 

The Section Sets spreadsheet should look like this: 

 

Section sets provide an easy way to manage members that are repetitive. This will become even more 

apparent when you have RISA-2D choose new and/or optimized member sizes.  

So far, your truss has only nine web members. But, what if you had three trusses and were required to 

change the section (as you will do in Tutorial 2). Changing 27 member properties one at a time could 

take some time. By defining section sets, you will be able to globally change the truss web member 

properties by changing only one section on the spreadsheet. 

  



Tutorial 1 – Modeling 

40 

Hot Rolled Sections and Database 

You currently have one section set for each material type. Next, you will add some section sets and 

change the labels so that they are more useful. The active cell (denoted by green color) should contain 

the text HR1. You have not yet defined any members with this section, but you will be using it for the 

beams in your steel moment frame.  

Give the section a more descriptive label and change the material: 

 In row 1, under the Label column, type Stl-Beam.  

 Also in row 1, Under the Material column, select A992.  

 Press ENTER. 

The spreadsheet should now look like this: 

 

When you press ENTER, a new row will be created (which you do not need for this model). Delete the 

newly created row: 

 On the Window toolbar, click Delete Line  (now that you are in spreadsheet view, notice the 

Window toolbar has changed). 

Notice that the Section Set data consists of a number of other entries. The Shape entry indicates the 

current size that will be used for the member. The Type entry indicates whether the member is a beam, 

column, or brace. This is especially important for the design of concrete sections.  

The Design List and Design Rules entries define the list of shapes to be used and the design restrictions 

to impose when redesigning and/or optimizing the member. For more information on customizing 

design lists, refer to Appendix A in RISA-2D General Reference. 

Finally, the A, Iyy and Izz columns list the area and moments of inertia for the current shape.  

Modify the Design Rules: 

 In row 1, under Design Rules, click the cell to reveal the list of available options. Select Steel-

Bms.  

By default the current shape is a W10x33. If you know what shape you want to use, you may type it in 

directly. Or, if you are not sure, you may open the database and review the full list of available shapes. 
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Define the Hot Rolled shape: 

 In row 1, under Shape, click the cell to make this the active cell.  

 

 Click the red arrow on the right to open the Hot Rolled Shape Database. 

The Hot Rolled Shape Database dialog box looks like this: 

 

The left side of the dialog box contains a list of available shapes. The selected shape is currently 

W10x33. Change the shape selection: 

 In the Shape Type list (on the left), select W12X19. Use the PAGE UP and PAGE DOWN keys on 

your keyboard to quickly move through the list. 

 Click OK to return to the spreadsheet. 

On the Section Sets spreadsheet, notice that W12X19 is now in the Shape column. The remaining 

properties will be updated as soon as you leave the cell: 

 Press the TAB key to advance to the next cell and update the geometric properties. 
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Cold Formed Sections and Database 

Now, you will add your Cold Formed Section Set. Open the Cold Formed spreadsheet: 

 On the Section Sets spreadsheet, click the Cold Formed tab.  

 Under Label, type Girt to make the label more descriptive.  

Your screen should now look like this: 

 

Once again, select your shape from the shape selection database.  

 Click the first cell under the Shape column. Click the red arrow on the right to open the Cold 

Formed Shape Database.  

The Cold Formed Shape Database is very similar to the Hot Rolled Shape Database, and looks like this: 
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Review and modify the shape settings: 

 Under Shape Type, click CS. 

 Under Database/Manufacturer, select AISI 2007. 

 Under the list of available shapes (on the left), select 12CS4X070. 

 Click OK to return to the spreadsheet. 

On the Section Sets spreadsheet, notice the A and I properties will be updated as soon as you leave the 

cell: 

 Click in the first cell under Design List, making this the active cell. Click the cell a second time to 

display the available design lists.  

 Select CS. 

This final step will ensure that when RISA-2D performs member redesign and/or optimization, it will 

suggest a new CS from within the appropriate parameters set in the Design Rule: 

 Click in the first cell under Design Rules two times to display the available design lists.  

 Select Steel-Bms. 
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Wood Sections and NDS Database 

Moving now to wood, define the section used for the chords and webs of the wood truss.  

 On the Section Sets spreadsheet, click the Wood tab. 

 In row 1, under Label, type Chord.  

 Under the Material column, select DFL Select. Press ENTER to make a new row. 

 In row 2, under Label, type Web. 

The spreadsheet should now look like this:  

 

The Shape is currently set to 2x6 for both members. This is sufficient for the web members; but for the 

chords, it is preferable to use doubled members: 

 In row 1, click the first cell under the Shape column. Click the red arrow on the right to open the 

Wood Shape Database.  

 Select 2 for the number of plies. 

The dialog box should look like this: 
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Return to the Section Sets spreadsheet: 

 Click OK. 

You have now changed the current shape to a double 2x6. To modify RISA-2D so that it will suggest 

Double Rectangles when performing member redesign and/or optimization, you must also change the 

Design List: 

 In row 1 (labeled Chord), click the first cell under Design List two times to display the design 

lists. 

 Select Rectangular Double.  

 In row 2 (labeled Web), click the first cell under Design List two times to display the design lists. 

 Select Rectangular.  

This last step will ensure that the when RISA-2D performs member re-design and/or optimization, it will 

suggest another doubled up member for the chords. To also control the depth and thickness of the 

suggested shapes, modify the Design Rules. 

Modify the Design Rules: 

 In row 1 (labeled Chord), click the first cell under the Design Rules column two times to display 

the available design lists. Select Truss-Rules. 

 In row 2 (labeled Web), click the cell under the Design Rules column two times to display the 

available design lists. Select Truss-Rules. 

Your spreadsheet should now look like this: 
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Concrete Sections 

Open the Concrete tab: 

 On the Section Sets spreadsheet, click the Concrete tab.  

Take a minute to review the information listed under the Concrete tab. It is similar to the information in 

the other tabs for steel and wood. 

Define the labels and the shapes:  

 In row 1, under Label, type Conc-Col.  

 In row 1, under Shape, type CRECT12x12. Press ENTER to create a new row.  

 In row 2, under Label, type Conc-Bm. 

 In row 2, under Shape, type CRECT12x8. 

The spreadsheet should now look like this:  

 

Define the type and set the design list:  

 In row 1, under Type, click the cell two times to list the available types. Select Column. 

 In row 1, click the first cell under Design List two times to display the design lists. 

 Select Rectangular.  

 In row 2, click the first cell under Design List two times to display the design lists. 

 Select Rectangular.  

Remember that your concrete reinforcing and cover information was specified as part of the Design 

Rules. This is currently set to Col-Rules for both sections. While this is correct for Conc-Col, use a 

different rule for the beams. 

 In row 2 (labeled Conc-Bm), click the cell under Design Rules two times to display the list of 

available options. Click Conc-Bms. 

Your spreadsheet should now look like this: 
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Aluminum Sections 

Lastly, open the Aluminum tab: 

 On the Section Sets spreadsheet, click the Aluminum tab.  

Take a minute to review the information listed under the Aluminum tab. It is similar to the information 

in the other tabs for steel and wood. 

Define the shape:  

 In row 1, under Label, type Alum-Bm.  

 In row 1, click the cell under the Shape column. Click the red arrow on the right to open the 

Aluminum Shape Database.  

 Under Shape Type, select Rect Tube. 

 From the list of available shapes, select RT6X6X0.125. 

 Click OK to return to the Section Sets spreadsheet. 

 From the Design List menu, select Rectangular Tubes. 

 From the Material menu, select 6061-T6. 

 And finally, select Alum-Rules from the Design Rules menu. 

When complete your spreadsheet should look like the following: 
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Multiple Windows 

 

At this point, you should have a model view and three spreadsheets open and visible on your screen. 

Notice the “active window” is denoted by a colored title bar (in this case, the Aluminum Section Sets 

spreadsheet). The title bars of the other inactive windows are dimmed. The windows are tiled in the 

order that you opened them. You can return to any of the windows by clicking anywhere on them, 

preferably on the title bars, so you do not accidentally click a button or a grid point. 

Note: To move a window, press and hold the title bar with your mouse, then drag to the desired location.  

You can also access the open windows and dialog boxes through the Window menu. This menu allows 

you access to windows that may be hidden from view. 

 Click the Window menu. 

 

The Window menu presents some 

window arrangement and tiling options. 

The open windows are listed in the order they 

were opened. You can select any of the open 

windows to make it active. 

The active window is denoted by a 

check mark. 
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Change the active window to model view: 

 On the Window menu, select 1 Model View. 

The model view becomes the active window and moves to the front of the other windows. The 

spreadsheets are still open beneath the model view window, but not currently visible. 

You can also recall open windows the same way you originally opened them (by selecting from a menu 

or clicking a toolbar button). For example, to make the currently open Section Sets spreadsheet become 

the active window: 

 On the Data Entry toolbar, click Section Sets to open the Section Sets spreadsheet. 

Close the active window: 

 Click Close  or press CTRL+F4 to close the Section Sets spreadsheet. 

Now, the model view should be your active window. Notice that RISA-2D resumes where you left off for 

all open windows. The cursor  indicates you are still in drawing mode for web members, so open the 

Draw Members dialog box and change the settings so that you can now draw the crossbeam: 

 Press CTRL+D to recall the Draw Members dialog box. 

 Under Member Material Type and Shape, click Hot Rolled. 

 Click Assign a Section Set. On the list of available section sets, click Stl-Beam (if it is not already 

selected). 

 Under Release Codes, click Fully Fixed at Both Ends. 

When you are finished, your screen should look like this: 
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Exit the dialog box and return to the model view: 

 Click Apply. 

Begin drawing the cross beams: 

 Draw members from point A to point B using the grid locations shown below. 

 Click the right mouse button or press ESC to release the mouse. 

 

Your image should now look like this: 

 

  

Grid Locations: 

Point A (0,10) 

Point B (21,10) 
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Entering Spreadsheet Data 

In addition to its graphical editing features, RISA-2D allows you to add, organize or sort your data using a 

series of powerful spreadsheets.  

Explore the Joint Coordinates spreadsheet: 

 Click the Spreadsheets menu. Click Joint Coordinates. 

 

The Joint Coordinates spreadsheet will display: 
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Next, you will be adding a lower concrete frame and masonry shear wall to support the rest of your 

structure. You could modify the grid to help you draw in the new elements, but instead, you will use the 

spreadsheets to manually enter the additional joints that define the base of the frame.  

Create a new row in the spreadsheet: 

 In row 16, click N16. Press the ENTER key to create a new row. 

 In row 17, under the Y column, type -10. Press the ENTER key to create another new row. 

 In row 18, under the X column, type 21. Under the Y column, type -10. 

Your image should now look like this: 

  

You have now finished adding all the joints necessary for this tutorial. Close the spreadsheet and return 

to the model view to continue drawing members (the spreadsheets will be covered more in Tutorials 2 

and 3): 

 Click Close  to close the spreadsheet. 

 On the Window toolbar, click Redraw  to redraw the full model view. 

The new joints you created should now be visible below the existing columns.  
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Drawing Concrete Members 

Open the Draw Members dialog box again: 

 Press CTRL+D to reopen the Draw Members dialog box.  

Notice that the dialog box retained the properties you entered when drawing your steel cross beam. 

Modify it now to be consistent with the new concrete member that you are going to enter.  

 Under Member Material Type and Shape, click Concrete.  

 Then, click Assign a Section Set. On the list of available section sets, click Conc-Col (if it is not 

already selected). 

When you are finished, the dialog box should look like this: 

 

Exit the dialog box and resume drawing: 

 Click Apply. 

  



Tutorial 1 – Modeling 

54 

Next, draw in the new members: 

 First, click joint N17 and then N1. 

  

 Next, click on joint N3 and finally N18. 

 Right click to release the drawing tool. 

This will create a new vertical member from N17 to N1, a new horizontal member from N1 to N3, and a 

new vertical member from N3 to N18.  

Your screen should now look this: 
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Boundary Conditions 

Boundary conditions define how the model is constrained. All models must be attached to some 

external point(s) of support (otherwise an error message will display notifying you that your model is 

unstable).  

Prepare to add boundary conditions at the base of the columns: 

 On the Drawing toolbar, click Boundary Conditions . 

This dialog box will display: 

 

  

Boundary conditions can be applied 

to any joint. There are three degrees 

of freedom for each joint; therefore, 

there are three parameters 

provided; one for each direction. 
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Review the options for assigning boundary conditions. Each option is described below: 

 In the X Translation list, click the down arrow to see the available boundary condition options. 

    

 

Free No restraint.  

Reaction Specifies full restraint for the indicated direction. No movement will be allowed in 

the indicated direction for this joint. A reaction force will be calculated and 

reported. 

Fixed Similar to Reaction, this option also specifies full restraint for the joint in the 

indicated direction; however, no reaction force is calculated. This setting actually 

removes the degree of freedom from the solution. If you are not interested in 

reactions, using this option will result in a slightly smaller model. 

Spring This option models a spring attached to the joint in the indicated direction and must 

be accompanied by a spring stiffness. The units for the spring stiffness depend on 

whether the spring is translational or rotational and are displayed next to the edit 

box. 

For example, to specify a spring of stiffness 100 kips per inch, select Spring from the 

list and type 100 in the adjacent box. 

Compression 

Spring 

This option models a compression-only spring and must be accompanied by a spring 

stiffness. This type of spring will only resist compression (negative displacement); if 

a tension force (positive displacement) is applied to it, it will release and provide no 

resistance. 

Tension Spring This option models a tension-only spring and must be accompanied by a spring 

stiffness. This type of spring will only resist tension (positive displacements); if a 

compression force (negative displacement) is applied to it, it will release and 

provide no resistance. 

Slave This option “slaves” the degree of freedom of one joint to another that you specify.  
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Next, specify pin supports at the base of your columns. For this tutorial, the X and Y translations will be 

restrained, but the rotation will be unrestrained. This is a common boundary condition that is built in to 

RISA-2D, and can be applied as shown below: 

 Click the Pinned button and the boundary condition settings described above will be completed 

for you. 

The dialog box should now look like this: 

 

 

Finish your selections and close the dialog box: 

 Under What happens when Apply is pressed?, select Apply Entries by Clicking/Boxing Joints 

(this important feature will be discussed in more detail later). 

 Click Apply. 

Note: Your cursor will change to , indicating you are ready to apply the boundary condition when 

you click any joint. 

Apply the boundary condition to the base of both columns at joints N17 and N18. 

 Click joint N17 and then on joint N18. 

  

The Use? check boxes must be 

selected for a modification to be 

applied. This allows you to 

change a condition for just one 

of the parameters, instead of 

requiring all three to match.  
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Your model should now look like this: 

 

Review how the boundary condition data you just entered graphically was recorded on the Boundary 

Conditions spreadsheet: 

 On the Data Entry toolbar, click Boundary Conditions to open the spreadsheet. 

 

RISA-2D allows you to edit existing boundary conditions here, or add new ones. To add a new boundary 

condition, you would simply type directly on the spreadsheet (you can type just the first letter such as 

“R” for Reaction, then press ENTER). Or, you can click the red arrow to view the available options.  

 

 

This is the end of Tutorial 1. The next tutorial demonstrates how to make modifications to the model. 

You may save your model to be used as the starting point for the next tutorial, or begin the next tutorial 

using the .r2d starter file in the RISA-2D Tutorials folder. To save the model: 

 Select Save As from the File menu. Enter in a file name and click Save. 
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Tutorial 2 – Modifying 

Overview 

In this tutorial, you will modify the 2D frame you defined in the last tutorial and use RISA-2D’s graphic 

editing features to expand it into a two-bay frame. This tutorial continues where the previous tutorial 

ended, so follow these steps to get your model up and running: 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

 Skip ahead to the next page. 

-OR-  If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA Technologies: 

 Double-click the RISA-2D icon to start the program. The Starting a Model dialog box will display. 

 Click Open Model . Double-click the Tutorials folder, select RISA-2D Tutorial 2 Starter.r2d 

and click Open.  

 Click Close  (or Cancel) to exit the (Global) Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

Your screen should look like this: 

 



Tutorial 2 – Modifying 

60 

To get started, you will modify the end conditions at the tops of the columns. Notice that the web 

members of the truss are pinned at the ends (indicated by the circle at the end of each member). All 

other members are fixed at the end. You will modify the column top ends so that they are pinned as 

well. 

Modifying an Item 

RISA-2D provides a quick and easy way to view and edit properties of any item in the model. You may 

simply double-click any joint, member, or plate to view and edit all of the information for that item. 

 Double-click the left steel column (anywhere between N1 and N2).  

This dialog box will display: 

 

Select each tab as follows: 

 Click the Properties and Design tabs to preview the different methods for adding or editing 

member information. 

Modify the end releases for the first column: 

 Click the End Releases tab. 

 Under J End Release Codes, click Pinned. 

 Click OK to close the dialog box and return to the model view. 

Next, define the end releases for the right column: 

 Double-click the steel column on the right (anywhere between N3 and N4) to open this column’s 

information dialog box.  

 Click the End Releases tab. 

 Under J End Release Codes, click Pinned. 

 Click OK to close the dialog box. 
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Notice pins should now be visible at the tops of the columns. 

 

Before proceeding, inspect one of the joints: 

 Double-click the bottom left joint (N17) to review the information. 

 Click Cancel to close the dialog box without making any changes. 

Note: This method of reviewing and editing model information is sufficient when modifying one or two 

items in your model. However, to modify several members at once, it is easier and more efficient to use 

the graphical selection and editing tools, described next. 

  

The open circles at the top of each 

column represent pin end releases. 

Note: If you do not see the open circles at 

the top of each column, click the  

I End-J End button  a few times to make 

sure the I-J end flags are on. 
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Editing the Model View 

This section explains how to modify the model view using the graphical selection and editing tools. Since 

you are currently working in a model view the Window toolbar will look like this: 

 

The first button on the left is the Model Display Options button  (used earlier to color the 

members). This will be explained in more detail later. 

Rotating the Model 

The Rotate buttons  are used to rotate the model counter-clockwise or clockwise 

about the Global Axes. The View buttons  are used to “snap” the view to the default 

isometric view, or the XY, YZ, or XZ planar view, respectively.  

 On the Window toolbar, click some of the Rotate and View buttons (shown above) and 

experiment with rotating and snapping the plot to different views. 

As you click the Rotate and View buttons, notice the direction the plot is rotating. It may help to 

reference the Global Axes icon at the top left corner of your model that looks like this:  

 

When you are finished experimenting, place the model in an isometric view: 

 On the Window toolbar, click Isometric . 

Zooming the Model 

The Zoom buttons are used to zoom the model view in and out. The first two Zoom In  and Zoom 

Out  of the model as a whole. The third, Box Zoom , allows you to zoom in on a specific area of 

interest. Try the box zoom now: 

 On the Window toolbar, click Box Zoom , then box any area in your model by pressing and 

dragging your mouse. Release the mouse. 

If your mouse has a wheel, you will also be able to zoom using the mouse wheel: 

 Roll the mouse wheel forward and backward a few times to see the zooming effect.  

 On the Window toolbar, click Redraw  to redraw the model within your window. 

Panning the Model 

With the mouse wheel, you will also be able to use RISA-2D’s panning feature: 

 Simply press down the mouse wheel anywhere on your model, then hold and drag to the 

desired location. This will drag your model to the new location. 

When you are finished, return to your original, full model view:  

 On the Window toolbar, click Planar XY , then Redraw . 
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Edit Using the Drawing Toolbar 

The Graphic Editing  button is used to turn the Drawing toolbar on and off in the current model 

view. 

 On the Window toolbar, click Graphic Editing  a few times. Notice the Drawing toolbar will 

turn on or off each time. When finished, leave the Drawing toolbar on. 

Saving Views 

If you create a customized view that you think you may use again, you can save it for future recall using 

the Save or Recall View button . (It may even be a good idea to use this feature whenever you create 

a view that takes some time.) Simply click the Save or Recall View button and assign a name to the 

saved view. All of the Model Display Options will be recorded and saved for later recall. 

Multiple Views  

RISA-2D provides the ability to display multiple views of your model using two powerful tools:  

Clone View  and New Model View . These tools allow you to keep your original model view 

(window) intact in one view, then create additional views to display different views of the model.  

 

Listed below are some scenarios in which you may want to use these tools: 

• To isolate specific parts of your model to see how those parts are affected by your 

modifications.  

• If you do not want to change your existing view, but need to view a different side of the model, 

simply open a new window to view the other side.  

• When viewing results, you can plot different results information in each view.  

  

New Model View  - opens a new window 

containing the current model view (but does not 

include any rendering or view modifications). 

Clone View - opens a new window containing the 

current model view (including any rendering or 

viewing changes you have made). 

Example 1. Notice the current model view is 

in ISO view and rendered--the cloned view 

is identical. 

Example 2. Even though the original model 

view is rendered and in ISO view, the New 

Model View opens in wireframe, Planar XY 

view (the RISA-2D default view). 
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Note: Each view, whether created with Clone View or New Model View, is independent and can be 

rotated, rendered, zoomed, selected, etc., without affecting the other model views. However, any 

modeling changes you make in any view will be automatically updated in the other views. 

Load Viewing Operations 

Load viewing functionality is provided to help you display and switch the loads. This will be discussed in 

more detail after your loads are defined. 

Remaining Viewing Buttons 

The remaining toolbar buttons control identifying information in the model view.  

On the Window toolbar: 

 Click Rendering  twice to turn on model rendering (discussed in further detail later). 

 Click Joint Labels  three times to view the joint label options. 

 Click Member Labels  to turn on the member labels. 

 Click I End-J End  three times to view the I-J end flag viewing options. 

 Click Boundary Conditions  a couple times to toggle the boundaries on and off. 

 Click Global Axes  a couple times to toggle the Global Axes icon on and off. 

 Click Member Color Basis  a couple of times to toggle the unity (bending) display. 

 Click Show Member Results  to turn on results display. 

 Click Reactions-Moments  three times to display the moments.  

 Click Deflected Shape  to turn on the deflected shape with undeflected shadow. 

 Click Distance Tool  to enable the measuring tool. 

Model Display Options 

The Model Display Options dialog box controls what is displayed on the plot. 

 On the Window toolbar, click Model Display Options . 

 Click the Members tab. Click the down arrow next to each list to view the available Model 

Display Options. 

When finished reviewing this dialog: 

 Choose the Color Coded option and select Section Set as the Color Basis. Click OK to close the 

dialog and return to our model view. 

Note: You may make any Model Display Options your default options by clicking the Save as Defaults 

button on the Misc tab.  
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Selection Tools 

Selection tools are necessary to identify and isolate specific parts of the model. 

Note: Currently, your cursor looks like this , indicating you are in the default selection mode. While in 

this mode, click any item to select or unselect it. 

Selected items appear in wireframe, color fill, or rendered view (depending on your Model Display 

Options selection). Unselected items appear as grey wireframe lines. Next, compare the two. 

Currently, all elements in your model are selected. Unselect the crossbeam: 

 Click the steel crossbeam (between N15 and N16) to unselect it. The color fill beam will become 

light grey in color, denoting that it is now unselected. 

Your model should now look like this: 

 

Experiment with selecting and unselecting members and joint locations, and viewing information on 

them. 

 Click a few of the lines and joints to see how the elements can be unselected, and then again to 

select them. 

Using the Selection Toolbar to Make Selections 

Rather than clicking to select one item at a time, you may use RISA-2D’s Selection toolbar to help 

you quickly achieve any selection you want.  

The Selection toolbar is the vertical toolbar along the left side of the screen.  

It provides selection tools to help you work with parts of the model. The toolbar is visible when 

your model is the active window (it will not be visible when working on a spreadsheet). 

Experiment with making selections using the selection tools. Feel free to try all of them as you 

cannot affect the model solely by selecting items. 

 

  

The crossbeam is 

now unselected. 

Note: When using the select and unselect tools, the cursor will remain in that selection tool 

mode so that you can make multiple selections. To terminate the chosen selection mode, click 

the right mouse button. 
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The selection tools are described below: 

  Select All and Unselect All  

Select/unselect the entire model. 

  Box Select and Box Unselect  

Draw a box around the part to be selected/unselected. Only items that are entirely in 

the box will be affected.  

  Polygon Select and Polygon Unselect  

Draw a polygon around the part to be selected/unselected (double click to end). 

When you have finished drawing the polygon, double click to complete the selection.  

  Line Select and Line Unselect  

Draw a line through all items to be selected or unselected. Simply click the mouse to 

begin drawing the line, drag to draw the line, then release the mouse to complete 

the selection. This tool is ideal for selecting the columns or web members in a truss. 

 Invert Selected  

Used to invert, or reverse, the selected state of the model. All selected items are 

made unselected, and all unselected items are made selected. This can be very 

useful when just a few items are to be selected in a large model; just click to unselect 

the items, then click Invert Selected to invert (or “flip”) the selection. 

 Criteria Selection  

Allows you to use other criteria to make your selections. Using the Select Items for 

Current View dialog box, you can: (1) Select items between defined coordinates; (2) 

Select items using their labels, such as all joints from N7 to N15; (3) Select members 

by defining multiple types of criteria such as orientation, section set, database 

shape, and material; and (4) Select plates by defining material, thickness, and 

orientation. 

 Save/Recall Selection  

Save or recall selection states of the model. If the model is altered after a selection 

state has been saved, the saved selection state will also be altered. After saving a 

selection state, any new items (joints, members, etc.) will be set to “selected.” 

To save a selection state, click Save and provide a name for the saved selection. You 

can have up to 16 different saved selections in a model. To retrieve a saved 

selection, choose the selection state from the list and click Retrieve. To delete a 

saved selection, choose the selection state from the list and click Delete. 

   Lock Unselected (unlocked) and (locked) 

Lock all currently unselected parts of the model. When Lock Unselected is pressed, 

this selection tool changes to . When locked, all unselected parts of the model 

will remain unselected and invisible--no matter what other selection buttons are 

pressed.  

To turn the lock off, press Lock Unselected a second time (returning it to the 

unlocked position ). 
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When you are finished experimenting with the selection tools: 

 Ensure that the Lock Unselected button is unlocked . 

Now that you have explored the various selection tools, use them to define and modify the model. 

Making Changes to Selections 

Unselect the entire model and change the viewing plane: 

 On the Selection toolbar, click Unselect All  to unselect the entire model.  

 On the Window toolbar, click XY Planar  to change the model view to an XY elevation. Then 

click Redraw  to maximize the viewing plane. 

Make some selections using the Line Select button: 

 On the Selection toolbar, click Line Select . Your cursor will change to , indicating that 

you are now in the line selection mode. 

 Draw a line through the truss web members, as shown below. Click your mouse to begin 

drawing the line near the leftmost truss web member, and drag past the rightmost web 

member, then release the mouse.  

 

All of the truss web members should now be selected. In the next section, you will use the current 

selection state to easily modify these members.  

  

Notice that the section set for 

all of your web members is 

listed as “Chord.” This is 

because there was only one 

wood section set available 

when you first drew your truss. 
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Modify Members 

In this section, you will use the Modify tools to edit your model. 

 On the Drawing toolbar, click Draw New Members .  

 Click the Modify Properties tab. 

Note: Each section of the dialog box contains a Use? check box. Selecting any of these Use? check boxes 

determines whether or not the parameter will be applied.  

This dialog box looks similar to the Draw Members dialog box because, after the members are drawn, 

this dialog box allows you to change any of those initial parameters. 

 Under Member Material Type and Shape, click Wood. 

 Click Assign a Section Set, and select Web. 

 At the top of the Member Material Type and Shape section, select the Use? check box. Once 

selected, the text will turn red.  

 Under What Happens when Apply is pressed? click Apply Entries to All Selected Members. 

The dialog box should now look like this: 

 

Apply the changes and close the dialog box: 

 Click Apply.   



 Tutorial 2 – Modifying 

 69 

Modify the section set for all of the selected members: 

 On the Selection toolbar, click Select All  to select the entire model.  

 On the Window toolbar, click Isometric  to display an isometric view of the entire structure. 

Your model should now look like this: 

 

Notice that your concrete cross beam is defined with the same section set as the columns. Next, you will 

change this to the Conc-Bm section you created in Tutorial 1.  

Open the Information dialog box: 

 Double-click the concrete beam (the lower beam between N1 and N3). The Member 

Information dialog box will appear.  

  Click the Properties tab. 

 

Redefine the section set: 

 Under Section Set, click the Section Set list to display the available options. Click Conc-Bm. 

 Click OK to close this dialog box.  
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Model Rendering 

A powerful graphics tool in RISA-2D is the ability to display a rendered image of the model. A rendered 

image shows each member plotted using a true scale representation of the shape assigned to the 

member. 

A rendered view offers some important benefits: besides producing a very detailed image, it also allows 

you to easily review member orientations and member connectivity. There are also rendering options 

(on the Model Display Options dialog box, Members tab) that allow you to adjust pullback length and 

rendering transparency. 

Turn on the model rendering: 

 On the Window toolbar, click Rendering . 

Copying Model Elements 

RISA-2D allows you to copy selected portions of the model. You will use this feature to turn your two-

dimensional model into a two-bay structure. 

 On the Drawing toolbar, click Linear Offset Copy  to open the Copy Selected Items dialog 

box. This feature is used to copy the currently selected portion of the model (in increments) in 

any or all of the global directions. 

 

Replicate your model in the X direction. 

 Under Axis Increments, in the first X inc. column, type 21. 

 Click Apply. 

Because the entire frame was selected, all the frames will be copied. (In addition to copying the joints 

and members, if you had any loads on the frames they would have also been copied.)   

  

Notice there are four fields used to 

specify increments in the X and Y 

directions. When typing values, you can 

separate entries using commas or use 

the “@” symbol to specify multiple 

equal increments. 
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Your structure should now look like this: 

 

Model Merge 

Now that you have copied over your frame, it is good modeling practice to run a Model Merge to “clean 

up” the model. Model Merge searches for duplicate nodes and members (with the same coordinates) 

and merges them into one.  

Run a Model Merge: 

 On the Drawing toolbar, click Model Merge . 

The Model Merge dialog box will appear: 

 

Note: You have the option of merging the entire model or only a selected part of the model depending 

on which options you select in this dialog box. 

 Click Apply. You will be presented with the results of the merge.  

 Click OK to close the dialog box. 
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Drawing Additional Members 

Next, you will add steel girts to the columns between the beams. Because there are no joints at these 

locations, you can either create a drawing grid (as you did in Tutorial 1), or you can insert joints on the 

columns (as you will do next).  

 On the Drawing toolbar, click Draw New Members . Click the Split Members tab. 

 Click Specific Location and type 14 in the box.  

 Under Physical, click Just Add Joints to Physical Members. 

 Under What happens when Apply is pressed?, click Apply Entries by Clicking Members 

Individually.  

 

Close the dialog box and begin to draw: 

 Click Apply. 

 Click once on each of the three steel columns. 

New nodes will appear on the upper half of the columns between the two beams. (You may use the 

mouse wheel to zoom in to see them closer.) 

 Press CTRL+D to re-open the Draw New Members dialog box. Click the Draw Members tab.  

 Under Member Material Type and Shape, click Cold Formed. Click Assign a Section Set, and 

select Girt from the list. 

 Under Release Codes, click Pinned at Both Ends. 
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You also want the cold formed members to be turned so that their strong axis resists wind load. Specify 

the rotation angle before drawing them: 

 Under Orientation, in the Rotate Section box, select 90. 

 

Close the dialog box and prepare to draw again. 

 Click Apply and you are ready to draw. 
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Draw from left to right: 

 Click N33 (coordinates: 0,14), N34A (coordinates 21,14), and N35 (coordinates 42,14) shown in 

the figure below.  

 

 When finished, right-click to release the mouse. 

Next, you  will draw in the final Auminum members.  To make this easier, you will modify the drawing 

grid. These settings allow you to set up a grid of graphical editing points along any orthogonal plane. 

They also allow you to automatically snap to the quarter or third points of existing members.  

 On the Drawing toolbar, click Modify Drawing Grid . Click the Snap To Options tab. 

 Under Member Snap Locations, click to clear the Third Points check box. The Quarter Points 

check box should already be selected.  

 Under Universal Snap Increments, make sure the Use Universal Increments check box is not 

selected. 

  

Coordinate Locations: 

N33: (0,14) 

N34A: (21,14) 

N35: (42,14) 
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The dialog box should now look like this: 

 

Close the dialog box and begin drawing: 

 Click Ok.  

Draw the aluminum tubes using the drawing points defined at the quarter points of the columns.  

 Select Members from the Insert menu to open the Draw Members dialog. 

 Under Member Material Type and Shape, click Aluminum. Click Assign a Section Set, and select 

Alum-Bms from the list. 

 Under Release Codes, click Pinned at Both Ends. Change the Orientation back to 0 degrees. 

 

 Click Apply to start drawing. 
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 Click the left column coordinate (0,4.625). Then click the middle column coordinate (21,4.625) 

and the right column coordinate (42,4.625).  

 

 When you are finished drawing, right click to release the mouse. Right click a second time to exit 

the drawing mode. 

When you are finished your screen should look like this: 

 

Next, you will modify your model by rotating the three steel columns 90 degrees.  

When you move your cursor over 

graphical editing points, a red dot 

appears. Check the Status bar to view 

the coordinate location of each point. 

Graphical 

Editing Point Status bar 

coordinate display 
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Selecting By Properties 

One way to select these members quickly would be to snap to an elevation view and use the Line Select 

 tool to draw a line through all columns at one time. Another method, which you will use below, is to 

use the Criteria Selection button  to select all members with the column properties. 

 On the Window toolbar, click Redraw  to view the entire model. 

 On the Selection toolbar, click UnSelect All . 

Now that the entire model is unselected, use the Selection Criteria tool to select just the three steel 

columns. 

 On the Selection toolbar, click Criteria Selection . Click the Members tab.  

 Under Parallel, in the Parallel to Axis list, click Y. 

 Under Member Properties, in the Material list, click A992.  

Your dialog window should look like this: 

 

Once you click OK, all the steel columns should now be selected: 

 Click OK. 

  

Use this dialog box to select joints, 

members and plates by the 

properties that define them.  
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Your model should look like this: 
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Modify Members 

You will now rotate your columns. 

 Select Members from the Modify menu. 

Begin by clearing the previous selections. 

 Click the Clear Use button at the bottom. 

Now, set the orientation angle: 

 In the Orientation section, select the Use? check box. 

 Under Orientation, in the Rotate Section list, click 90. 

 Under What Happens when Apply is pressed? click Apply Entries to All Selected Members. 

The dialog box should now look like this: 

 

Apply the changes and close the dialog box: 

 Click Apply.  
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Notice now that these three columns have rotated 90 degrees about their vertical axes: 

 

Reselect the entire model: 

 On the Selection toolbar, click Select All  to select the entire model.  

Scaling Elements 

Assume your client has just submitted a change order to raise the truss from 18'-6" to 22'-9", and would 

like the frame 25% wider (from 21' to 26'3"). The client would like the completed design this afternoon! 

These are significant changes to the model. If you were using a batch input program or a program 

heavily reliant on “parametric” data generators, you would probably be required to start the data entry 

process completely from scratch to create the new model.  

A major strength of RISA-2D is the ability to make these types of changes to existing data. RISA-2D 

allows you to make all the requested changes graphically (using the built-in graphical editing tools), or 

numerically (using the spreadsheets), or a combination of both—whichever you prefer. Either way, the 

modifications will be quick and easy to model. 

For this tutorial, you will make the changes graphically. To begin, widen the truss using the Scale 

feature: 

 Click the Modify menu and select Scale. 

Note: This tool is also available on the Drawing toolbar, as the Scale Factor Move button .  
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To widen the truss, scale the model in the global X direction. 

 Under Scale Factor, in the X Factor box, type 1.25. 

 

 Click Apply. 

You are now finished widening the truss. Next, you will raise the truss. You cannot use the Scale feature 

to raise the truss because it would also lift the crossbeams. So instead, use the Move feature. Because 

you want to move the truss and nothing else, you must first make a selection of the truss. 

It will be easier to work with an elevation, so change the elevation, then select your truss: 

 On the Window toolbar, click XY Planar . 

 On the Selection toolbar, click Unselect All . Then, click Box Select . Draw a box around 

the entire truss. Right-click to release the selection tool. 

Your selection of the truss should look like this: 

  

The Scale Origin is the point that 

will remain stationary as the 

selected items are scaled. 

Scale Factor defines the scale 

factors in each global direction. 
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Change the elevation as follows: 

 On the Drawing toolbar, click Linear Translation Move .  

 Under Move Distance (ft), double-click in the Y box and type 4.25. 

 

 Click Apply.  

Note: You could have also used the Block Math feature in the spreadsheets to accomplish both 

modifications numerically. To widen the structure, you would have simply multiplied the joint X 

coordinates by 1.25. To raise the truss, you would have first sorted the Y coordinates and then selected 

the coordinates that are at an elevation of 8.5 ft or higher. The final step would have been to use the 

Block Math feature to add 4.25 to these selected Y coordinates.  
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Wall Panels 

The final model modification will be the addition of a wall panel under one bay of the model. In order to 

draw this in, you must first delete the concrete members and boundary conditions on the right side of 

the structure. 

Use the Selection Criteria tool to select the members you will need to delete: 

 On the Selection toolbar, click Unselect All . 

 On the Selection toolbar, click Criteria Selection . Click the Members tab.  

 Click on the Clear Selection Criteria button to clear the previous selection. 

 Click on the Material menu and select Conc3000NW.  

 

 Click on the Coordinates tab. 

 Click in the Minimum cell for the X Coordinate. Type in 26.25. 

 Click in the Maximum cell for the Y Coordinate. Type in 0. 

 

 Make sure the Include Criteria On Other Pages checkbox is selected and click OK. 
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Your model should now look like this: 

 

Now to delete the concrete members: 

 From the Drawing toolbar, select Delete . 

 Select Delete Based on This Criteria and select Delete Selected Members, as shown below: 

 

 Click Apply. 
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Finally, you will need to delete the boundary conditions but not the nodes at the base. To do this, simply 

delete the lines from the appropriate spreadsheet: 

 From the Spreadsheets menu, select Boundary Conditions. This will open the Boundary 

Conditions spreadsheet. 

 Click in the Joint Label cell of row 2 to highlight that cell in green, making it the active cell. 

 

 Press the F4 button twice to delete rows 2 and 3. 

When completed, the spreadsheet should look like this: 

 

 Close the spreadsheet. 

Now, you can draw in your wall panel.  

  On the Drawing toolbar, click Draw New Wall Panels . 

 Under the Material section, select Masonry. 

 

 Click Apply to draw in the wall panel using the default values. 
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Note: Your cursor will now change to , indicating you are ready to draw your wall panel. 

Begin drawing the wall panel: 

 Click each node to define the four corners of the structure: start with N18 (coordinates 26.25, -

10), then move clockwise to N3 (coordinates 26.25, 0), N21 (coordinates 52.5, 0), and finally 

N36 (coordinates 52.5, -10).  

 When finished drawing the wall panel, press the right mouse button or ESC to exit the drawing 

mode. 

Your screen should now look like this: 
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Notice the default rendered wall panel does not fully extend to its corner nodes. This is because the 

default view for wall panels has a rendered size of 80%. Change this to a size of 100% for a better view: 

 On the Window toolbar, click Model Display Options . Select the Panels tab. 

 Under Draw Wall Panels As, click Rendered. In the Size list, click 100%. 

 Click OK to exit the dialog box and return to your model.  

Your wall should now be rendered at 100%. 

 

This was just a simple overview of the masonry wall panel feature. For more detailed information on this 

feature and how to use it to set up design rules, regions, and openings for both masonry and wood 

walls, refer to the Wall Panel Tutorials available on our website: 

http://www.risa.com/d_documentation.html.  
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Design Parameters 

Before solving the model, design code parameters, such as unbraced lengths, must be specified. Once 

again, you will assign these values graphically. To view the parameters for any one member you can also 

double-click that member. The values will be recorded on the Member Design Parameters spreadsheet. 

 First, select your entire model by clicking on the Select All  button from the Selection 

toolbar. 

 On the Modify menu, select Design Parameters. Click the Modify Design tab (if it is not already 

selected). 

 In the Lb/le/Lu (out) box, type Segment (or Seg). Also, select the Use? check box. (It will display 

in red once it is selected.) 

 Under What happens when Apply is pressed?, click Apply Entries to All Selected Members as 

shown below: 

The dialog box should look like this: 

 

Currently, all the options are left blank except the first:  

 Click Apply.  

To visually see the settings for the unbraced lengths, you can double-click any member, click the Design 

tab, then review the unbraced lengths (this information is also accessible from the Members 

spreadsheet). 

  

These parameters are used to specify 

unbraced lengths. If left blank, RISA-2D will 

calculate the full length of the member. 

For weak axis bending, as a result of using 

the Segment code, each node will be treated 

as a brace point. 

Parameters with three labels separated by a 

slash (/) indicate steel/ timber/concrete. 
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Each parameter is described below. Refer to the Help or RISA-2D General Reference for more 

information.  

Flexural Properties 

Lb-comp/le-bend The Lcomp values (used for steel) are the laterally unbraced length of the 

compression flanges used in the calculation of member strength. The le-bend 

values (used for wood) are used in the calculation of RB. 

CH/w1 and 

Cm/w1 

CH is the NDS shear stress factor. The Cm factor, used in the calculation of the 

bending stress ratio for steel allowable stress design, may be entered if you wish to 

use a specific value. If left blank, it will be calculated by RISA-2D. 

Cb/w2/B Lateral-torsional buckling modification factors. If you leave the Cb factor blank 

during allowable stress design, RISA-2D will calculate it for you.  

R (AISI) Per section C3.1.3 of the AISI. Used to calculate the moment capacity of cold 

formed beams that have one flange fastened to decking. 

C1 (Euro HR) Factor used in the calculation of the LTB capacity per the Eurocode. 

Concrete Properties 

Icr Factor (ACI) Cracked moment of inertia factor for concrete design. 

Effective Width These are the effective width values used in T-Beam and L-Beam concrete sections. 

Slab Thickness These are the slab thicknesses used in T-Beam and L-Beam concrete sections. 

Layouts Reinforcement layouts for concrete member design. These can be set to default for 

program design, or set to a custom rebar layout. 

Axial/Torsional Properties 

Lb/le/Lu Unbraced lengths for in plane and out of plane buckling of the member (where Lb 

is steel and le is wood). These are used in KL/r ratio calculations for steel & 

concrete, and le/d calculations for wood. 

K factors Effective length factors for column type buckling. A value of 1.0 will be used if left 

blank.  

General/Misc Properties 

Function Function for stiffness reduction per the AISC 360-10 (14th Edition) Steel Code Direct 

Analysis Method design. 

Design Rules Design rule for design optimization. 

CV (NDS) This is the volume factor for glued laminated or SCL wood design per the NDS. 

Sway check 

boxes 

These check boxes indicate whether the member is to be considered subject to 

sidesway or not for in plane or out of plane bending (applies only to the calculation 

of K factors, Cm and Cb factors). 

Cr (NDS) This is the repetitive member factor used in NDS wood design. 
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Sorting 

Next, you will sort information in your model using the Joint Coordinates spreadsheet for the first time. 

To be able to view the spreadsheet and the model view side by side, use the Tiling feature: 

 On the RISA toolbar, click the Tiling button.  

 Select Joints Input. 

 Click OK. 

This tiling option has opened the Joint Coordinates spreadsheet in the upper left corner and placed the 

Joint Boundary Conditions spreadsheet below it: 

 

The joints are listed in the order in which they were created as you defined your model. However, it 

would be more useful to list them based on their coordinate locations. Sort the joints in ascending X 

coordinate order: 

 On the Joint Coordinates spreadsheet, click anywhere in the X column. 

 On the Window toolbar, click Sort , select Sort Low to High, and click OK. 
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The joints are now sorted in ascending X coordinate order. Now, add a Y-coordinate sort: 

 Click anywhere in the Y column.  

 Right-click the mouse, select Sort , click Sort Low to High, and click OK. 

Now you have the joints in ascending Y coordinate order as well as in ascending X coordinate order. 

Notice that the labels stayed with their assigned joints, and the model plot looks exactly the same. 

Relabel the joints as follows: 

 On the Tools menu, select ReLabel Joints.   

  Type an “N” in the Prefix to be used for the new joint labels box.  Click OK. 

The model should now look like this: 
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Notice the joints have been relabeled from the bottom up. Next, sort the members. 

 On the RISA toolbar, click Tiling again. 

  Select Members Input. 

 Click OK. 

This displays all spreadsheets that contribute to the definition of members. The Members spreadsheet is 

located in the lower left corner. Use this to sort the members, first by their I-Joint: 

 On the Member Primary Data spreadsheet, click anywhere in the I-Joint column.  

 Right-click the mouse, select Sort , click Sort Low to High, and click OK. 

Then sort by the section set: 

 Click anywhere in the Section/Shape column. 

 Right-click the mouse, select Sort , click Sort Low to High, and click OK. 

Again, the member labels remain with the same members and the view has not been affected by the 

sort (because nothing has actually changed other than how the members are arranged in the 

spreadsheet). 

Next, sort your beams by section. This will make them easier to identify and work with in your next 

operation (assigning parameters for steel and wood design):  

 On the Tools menu, select Relabel Members.  

 Type an “M” in the Prefix to be used for the new member lables box.  Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is the end of Tutorial 2. The next tutorial demonstrates how to load the model. 

You may save your model to be used as the starting point for the next tutorial, or begin the next tutorial 

using the .r2d starter file in the RISA-2D Tutorials folder. To save the model: 

 On the File menu, click Save As and enter a file name.  
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Tutorial 3 – Loading 

Overview 

In this tutorial, you will apply loads and explore how to generate load combinations from pre-defined 

load cases. This tutorial continues where the previous tutorial ended, so follow these steps to get your 

model up and running: 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

 Skip ahead to the next page. 

-OR-  If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA Technologies: 

 Double-click the RISA-2D icon to start the program. The Starting a Model dialog box will display. 

 Click Open File . Double-click the Tutorials folder, select RISA-2D Tutorial 3 Starter.r2d and 

click Open.  

 Click Close  (or Cancel) to exit the (Global) Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

Your model should look like this: 
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Load Cases, Categories, and Combinations 

Before you load the model, it is important to understand how RISA-2D manages loads. When loads are 

defined in RISA-2D, they are assigned to a Basic Load Case, which is simply a set of loads. You can have 

up to 1000 separate basic load cases (BLCs) defined in the Basic Load Cases spreadsheet. RISA-2D also 

provides an option to assign the BLCs to Categories (DL, LL, etc.), which allows you to easily combine 

them later in the Load Combinations. When you are ready to solve the model, the BLCs (or BLC 

categories) are combined with multipliers to create load combinations in the Load Combinations 

spreadsheet. 

In order to keep your loads organized, first define your Basic Load Cases. Then, when you apply your 

loads, specify which load case each will be assigned to. Although a description is not required by RISA-

2D, below you will give a description for the BLCs you will be using. 

 On the Spreadsheets menu, click Basic Load Cases to open the Basic Load Cases spreadsheet. 

 Under BLC Description, in row 1, type Roof Load. Press ENTER. 

 In row 2, type Wind Load. Press ENTER. 

 In row 3, type Dead Load. Press ENTER. 

Your spreadsheet should now look like this: 

 

Next, you will apply the loads and then come back to this spreadsheet to discuss it further. 

 Click Close  to exit the spreadsheet. 

Load Direction Options 

RISA-2D allows you to specify the direction of your loads in different ways. The three basic choices are: 

• Apply loads aligned with global axes, designated with upper case labels such as X and Y. 

• Apply loads aligned with member or plate local axes, designated with lower case labels such 

as x and y. 

• Apply projected loads along global axes, designated with upper case labels such as V and H. 

There is no need to worry about remembering the options, as you will be presented with this list each 

time you define the loads in RISA-2D. Also, the Help menu will provide explanations as needed. 

The remainder of the spreadsheet is 

now blank because you have no 

loads applied. 
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Joint Loads 

First, apply Joint Loads to the top of the truss. These will represent your roof load and will be grouped in 

Basic Load Case 1. 

 On the Insert menu, select Joint Load. 

The Joint Load dialog box will display. Here you can specify that you want to apply a joint load, an 

enforced displacement, or a mass on the joint. Leave it set to joint load. 

The direction that you want is the vertical direction. The global axes are plotted in the model view and 

the vertical is Y. Remember that positive is up. Modify the dialog box as follows: 

 In the Basic Load Case list, click 1: Roof Load. 

 In the Direction list, click Y. 

 In the Magnitude box, type -4. 

 

Finally, specify how the loads are applied. As you did with the boundary conditions, apply the load by 

clicking the joints: 

 Under What happens when Apply is pressed?, click Apply Load by Clicking/Boxing Joints. 

 Click Apply.  
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The cursor changes to  indicating that you can click or box the joints. Apply loads to the interior 

joints on the top of the trusses and apply loads of different magnitudes to the outer joints: 

 Draw a box around the interior top chord joints, as shown below: 

 

The loads will be applied to the interior joints. If you make any mistakes, click Undo . 

 If you cannot see the entire load, click Zoom Out .  

Return to the Joint Loads dialog box and change the magnitude: 

 Press CTRL+D to return to the last dialog box. 

 In the Magnitude box, type -2. 

 Click Apply. 

Return to your model view. Apply more loads: 

 Click nodes N29 and N38 to specify the two exterior panel points on the top chord. 

  

Draw a box around 

the interior top 

chord joints. 
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When you are finished your model should look like this: 

 

Distributed Loads 

The wind load will be applied as a 250 plf distributed load. 

Apply these loads by clicking on the members to demonstrate this method. 

 On the Drawing toolbar, click Distributed Loads .  

The Distributed Loads dialog box will display. Apply the settings for the distributed load: 

 In the Basic Load Case list, click 2: Wind Load. 

 In the Direction list, click X.  

 In the Start Magnitude box, type -0.25 (notice the same value is automatically entered as the 

End Magnitude value.) 

 Under What Happens When Apply is Pressed? click Apply Load By Clicking Members/Wall 

Panel Edges Individually. 
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Close the dialog box and prepare to select the members. 

 Click Apply. 

To apply the load, return to your model view and select the members: 

 Click the steel column on the right side. The loading will be applied.  

 Right-click the mouse to exit the drawing mode. 

Your model should now look like this: 
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Basic Load Case Spreadsheet 

To verify that the loads you applied graphically are correct, review them in the spreadsheets. 

 On the Spreadsheets menu, select Basic Load Cases to open the Basic Load Cases spreadsheet.  

The Basic Load Cases spreadsheet is where you named your Basic Load Cases earlier. Notice that there 

are now some numbers on the right side of the spreadsheet. These numbers summarize the loads you 

just defined. In row 1, in the Joint column, the 10 represents the 10 joint loads that you placed in the 

Roof Load case. The 1 in the Distributed column represents the distributed wind load. 

 

Open the Joint Loads spreadsheet to verify the loads that were assigned to BLC 1.  

 In row 1, in the Joint column, click the 10.  

The Joint Loads spreadsheet opens, displaying the loads that were assigned to BLC 1. Later, you will 

define the dead load listed on the Basic Load Case spreadsheet, and the Category and the Gravity 

columns will be explained.  

 

For now, close the Joint Loads spreadsheet and return to the Basic Load Cases spreadsheet: 

 Click Close  (or use the shortcut CTRL+F4) to close the Joint Loads spreadsheet. 

The numbers displayed in 

gray cannot be edited from 

this spreadsheet. However, 

you may click the entry to 

open the appropriate 

spreadsheet where the 

editing can be performed.  
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Copying Loads 

After taking the time to define a complex load case, you may realize that another load case is very 

similar to it. To save time when defining the second load case, you may find it useful to copy the first 

load case and modify the copy rather than start from scratch. For this purpose, RISA-2D provides the 

Copy BLC tool that allows you to copy all or part of a basic load case to another basic load case.  

The spreadsheet now defines the roof live load as 10 joint loads. In this step, you will add dead load at 

the roof level. Because the live load only differs by a factor, use the Copy BLC tool to copy the live load 

into the dead load case, then modify it using the Block Math feature: 

 On the Window toolbar, click Copy BLC . The Copy Basic Load Case dialog box will appear.  

 Under Copy the Loads FROM this Basic Load Case, select 1: Roof Load.  

 Under INTO this Basic Load Case, select 3: Dead Load. 

The dialog box should look like this: 

 

Close the dialog box: 

 Click OK. 

In row 3, there should now be a 10 in the Joint column.  
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Open the Joint Loads spreadsheet: 

 On the Basic Load Cases spreadsheet, in row 3 (Dead Load), in the Joint column, click 10 to 

open the Joint Loads spreadsheet for the Dead Load (BLC 3). 

Use the Block Math feature to change the magnitude of the load so that it represents the correct Dead 

Load. This can be done with a factor. 

 First, select all of the cells in the Magnitude column. A fast way to select the entire column is to 

click the Magnitude column heading. The entire column should now be selected and colored 

magenta.  

 

 On the Window toolbar, click Block Math  to open the Block Math dialog box. 

 Under Please enter the block math operand, type 0.25. This will make the Dead load 25% of the 

copied Roof Load. 

 Click MULTIPLY the block by the operator.  

The dialog box should look like this: 

 

Close the dialog box: 

 Click Ok. The joint loads should now have magnitudes of -1K and -0.5K (or one quarter of the 

Roof Live Load).  

 Click Close  (or use the shortcut Ctrl+F4) to close the Joint Loads spreadsheet. 
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Self-weight 

The last step in defining your loads is to define the self weight of the structure. You will add it to the 

same basic load case where you just placed the surface dead loads. To accomplish this, simply enter a 

factor in the Y Gravity column on the Dead Load Basic Load Case. 

 In row 3 (Dead Load), in the Y Gravity column, type -1.  

RISA-2D will now calculate and include the self-weight of the model during solution. The factor entered 

is a multiplier for the self-weight. In this case, “-1” is used because you want the full self-weight applied 

downward (the negative Y-direction). You may apply self-weight multipliers in the X or Y direction. 

Load Categories 

Before you close the Basic Load Cases spreadsheet, assign each load case to a Category. Categories are 

especially helpful in bringing all of your loads together, making it easier to later combine them for 

solutions. In this model, the loads are quite manageable and you could just refer to them by their BLC 

number. Many structures, however, will be modeled with multiple separate load cases that are part of 

the same family.  

Assign the associated categories to each basic load cases: 

 In row 1 (Roof Load), click in the Category column to display the list of available options. Select 

RLL (Roof Live Load). 

 In row 2 (Wind Load), click in the Category column. Select WL (Wind Load). 

 In row 3 (Dead Load), click in the Category column. Select DL (Dead Load). 

The spreadsheet is now complete and should look like this: 

 

Close the spreadsheet: 

 Click Close . 
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Load Combinations 

You will now define how the loads are to be combined. These combinations are analyzed when you 

solve the model and view results. Most standard code combinations are already built into RISA-2D,  and 

accessible through the Load Combination Generator.  

Next, you will apply the ASCE minimum design loads and then modify them. 

 On the Spreadsheets menu, select Load Combinations.  

Currently, there is no data available for the spreadsheet. Generate the load combinations using the LC 

Generator: 

 On the Window toolbar, click the Load Combination Generator button . 

The Load Combination Generator dialog box will display.  

 

Define the Load Combinations: 

 In the LC Region list, click United States. 

 In the LC Code list, click 2015 IBC ASD.  

 Under Wind Load Options, select the Generate check box.  

 Under Seismic Load Options, select the Generate check box.  

Note: For more information on the Wind Load Options and Seismic Load Options refer to the 

Generating Building Code Combinations section of RISA-2D General Reference. 

 Click Generate.  
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The following Load Combinations will be generated: 

 

The generated combinations may be edited in the spreadsheet. Each parameter is described below: 

Description Enter a descriptive label, and it will be displayed with the results when the 

load combination is solved. 

Solve This check box indicates whether this combination is to be included in the 

Batch or Envelope solution (that will be performed later).  

PDelta The PDelta flag indicates what type of P-Delta analysis you wish to run. P-

Delta calculations account for the secondary effects resulting from load 

eccentricities due to model deflections. 

SRSS The SRSS parameter is used to combine response spectra analysis results for 

different directions by taking the square root of the sum of the squares. 

(the 

remaining 

parameters) 

The remaining parameters define the actual combinations, with pairs of BLC 

columns and Factor columns. The values are exactly as listed in the code. 

 

Note: Instead of using categories, as shown, you may also list loads by the BLC number. For example, 

instead of using DL, you could reference the same load by typing the BLC number (3). Other options 

include nesting one combination within another and including response spectra results. For more 

information, refer to Help or RISA-2D General Reference.  
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Because you do not have an earthquake load, snow load, or rain load included in this model,  you can 

remove these unnecessary Load Combinations from the spreadsheet by deleting those rows.  

First, select the rows to be deleted: 

 Select rows 4 and 5 (load combinations IBC 16-10 (b) to IBC 16-10 (c)) by clicking directly on row 

4 (the row label), then drag down to row 5. Release the mouse. 

The spreadsheet now looks like this.  

 

Now, delete these rows: 

 On the Window toolbar, click Delete Lines .  

Note: After deleting, the row numbers will renumber, and you will be left with 16 combinations. 

  

The rows should now be shaded yellow. 

Note: If the cells are shaded magenta, 

you accidentally selected cells from 

within the spreadsheet instead of the 

row label. Click Undo  and try again. 
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Continue by deleting Load Combinations 5 (IBC 16-11 (b)) and 6 (IBC 16-11 (c)), this time using a 

different method: 

 In row 5, click in the Description column. Press the F4 key two times to delete rows 5 and 6. 

Delete a few more Load Combinations to finish: 

 Using whichever method you prefer from the above two options, delete the following Load 

Combinations: 

  IBC 16-12 (b) 

IBC 16-13 (b) 

IBC 16-13 (c) 

IBC 16-14 (a) 

IBC 16-14 (b) 

IBC 16-14 (c) 

IBC 16-16  

 When finished, verify that your spreadsheet matches this image: 
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The remaining Load Combinations are sufficient for your steel, wood,  aluminum, and masonry 

elements. However, you will need to add more load combinations for the design of your concrete 

members.  

 On the Window toolbar, click Load Combination Generator  again.  

The Load Combination Generator dialog box will display again. Define the load combinations: 

 In the LC Region list, click United States. 

 In the LC Code list, click 2015 IBC Strength.  

 Under Wind Load Options, select the Generate check box.  

 Under Seismic Load Options, click to clear the Generate check box.  Click Generate. 

The Load Combinations spreadsheet should now look like this: 
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With the requirements of the current design codes, you will need to include P-Delta effects in your 

results. This is not always included by default, but you can include it in the Load Combinations 

spreadsheet. 

 Use your cursor to highlight the PDelta column for all rows.  

 Click CTRL + F to open the Block Fill dialog box. 

 Type “Y” into the dialog box and click Ok. 

This will fill in the P-Delta column with Y, representing a “Yes, include P-Delta effects” for the steel 

design load combinations. 
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Review the Design settings: 

 Click the Design tab to view more Load Combination data.  

 Highlight the Hot Rolled and Cold Formed column checkboxes for lines 8-21 (the Strength load 

combinations) and use the Fill Block command (CTRL+F) to uncheck them all.  This way, these 

members will not be designed for strength level combinations. 

 

 Repeat for the Masonry column checkboxes for lines 8-21 and the Concrete column checkboxes 

for lines 1-7. 

Once, complete, the concrete members will be only be designed per the strength level combinations. 
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The data from the Design tab is described below: 

ASIF Used to enter the allowable stress increase factor (ASIF) for the design of hot 

rolled steel per AISC 9th Edition specifications. Since you are using the ASCE 

load combinations, this increase factor (usually 1.333 for wind or seismic 

loads) will not be used. An entry in this field greater than 1.0 is also used to 

indicate whether the seismic provisions of the LRFD code are to be used.  

CD The load duration factor used only in NDS wood design. This factor is 

dependent on the load with the shortest duration that is present in the load 

combination.  

ABIF Used to enter the Allowable Bearing Increase Factor for footing design (if you 

have RISAFoot also installed). 

Service This check box indicates whether the load combination is for service level 

loads. This will affect the stiffness used for concrete members during the 

solution.  

(the 

remaining 

parameters) 

The remaining parameters define which material types will be designed 

and/or checked for that load combination. Therefore, you will never get an 

NDS wood code check for the strength level load combinations used for 

concrete design.  

Review, then close the spreadsheet. 

 Review the information on your spreadsheet to make sure the design data is the same as above.  

 Click Close . 
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Displaying Loads 

RISA-2D provides easy ways to view your loads using the loads display buttons described below. The 

loads can be displayed as Basic Load Cases, Load Categories, or Load Combinations.  

 

To view the Basic Load Cases, first return to the original model view: 

 Select Single View from the Window menu. 

 On the Window toolbar, click Display Loads  and select BLC 2:Wind Load. If your loads do 

not appear, click Display Loads  once more to toggle them on. 

To view the Load Combinations: 

 On the Window toolbar, click Switch Loads  one time. 

Now you have the option to select any of the Load Combinations from your Load Combinations 

spreadsheet. This view will combine and factor the loads per the selected Load Combination. 

 

  

The Display Loads list changes to 

display all of the load combinations 

(instead of the basic load cases). 

Also, the list displays the loads as 

they are factored into the load 

combinations. 

Display Loads  - Turns 

the display mode on and off. 

Switch Loads  – alternates between the 

three different display modes: 

Basic Load Cases 

Load Combinations 

Load Categories 



Tutorial 3 – Loading 

112 

 Select LC 5: ASCE ASD 5 (a). 

 

When you are finished viewing the Load Combinations, view the Load Categories: 

 On the Window toolbar, click Switch Loads  one more time. The Display Loads list will again 

change, now displaying the Load Categories. 

 View the loads by category by selecting them from the list. 

 

 

 

 

 

 

 

 

 

 

 

This is the end of Tutorial 3. The next tutorial demonstrates how to solve the model. 

You can save your model to be used as the starting point for the next tutorial, or begin the next tutorial 

using the .r2d starter file in the RISA-2D Tutorials folder. To save the model: 

 On the File menu, click Save As and enter a file name.  

Using the load display options 

provide a great way to verify the 

loads on your model. 

Note: The magnitudes of the loads 

represent the factored 

combination. For example, the 

displayed roof load magnitude is 

the combination of the dead and 

live loads multiplied by their 

factors. 
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Tutorial 4 – Solving & Results 

Overview 

The last step in the modeling process is to solve the model and review the results. RISA-2D presents 

results in several ways. You may view the data in the spreadsheets, view a member detail report, or 

view the results graphically. This tutorial continues where the previous tutorial ended, so follow these 

steps to get your model up and running: 

If you are continuing from the previous tutorial: 

 From the Window menu, select Single View. 

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

 Skip ahead to the next page. 

-OR-   If you are starting here from scratch, follow the steps below to load the starter file provided by 

RISA Technologies: 

 Double-click the RISA-2D icon to start the program. The Starting a Model dialog box will display. 

 Click Open Model . Double-click the Tutorials folder, select RISA-2D Tutorial 4 Starter.r2d 

and click Open.  

 Click Close  (or Cancel) to exit the (Global) Model Settings dialog box.  

 On the Window toolbar, click the Graphic Editing Toolbar button  to activate the Drawing 

toolbar. 

 On the Data Entry toolbar, click Close  to close it. 

Your screen should now look like this: 
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Solve the Model 

In this tutorial, you will solve a few single load combinations, then solve all of the combinations and 

review the enveloped results. 

 On the RISA toolbar, click Solve .  

 Click Single Combination. In the Single Combination list, select 5: IBC 16-12(a).  

 

 Click Solve. 

RISA-2D reports the solution steps as they occur. When the solution is complete, two new items will 

display: the Joint Reactions spreadsheet and the Results toolbar: 

 

You may view results in the spreadsheets, plotted on the model view, or review the details for each 

member, as described below. Use the Results toolbar to quickly review the results.  

 On the Results toolbar, click some of the spreadsheets. 

  

The Results toolbar contains links to 

each of the results spreadsheets.  

(The spreadsheets are also available 

on the Results menu). 

Notice the reactions are totaled at 

the bottom of the spreadsheet. 

The center of gravity of the 

vertical loads is reported in the 

last row.  
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Now that you have an idea of what results are available, in the next section you will see how easily and 

quickly you can manipulate them. 

 On the Results toolbar, click Joint Deflections to review the results. 

 Next, click Member Forces to view the Member Section Forces spreadsheet. (Note that seven 

locations are listed for each member. This is because you specified seven sections when defining 

the (Global) Model Settings settings.) 

A powerful feature of the spreadsheets is that the data can be sorted various ways. Next, you will use 

the Sort feature to sort the strong axis moment results. 

 Under the Moment column, click any cell.  

 On the Window toolbar, click Sort  to access the sorting options.  

 Click Sort Abs Max to Abs Min. 

 

 Click OK. 

The members on the Member Forces spreadsheet are now sorted according to their absolute maximum 

bending moment value. Review the remaining spreadsheet data:  

 On the Results toolbar, click Member Stresses to view the Member Section Stresses 

spreadsheet. 

 Click Member Deflections to view the Member Section Deflections spreadsheet. This 

spreadsheet also shows the deflections as a ratio of member length (the L/y’ ratio) providing an 

easy check against deflection criteria such as L/360. 

 Click Suggested Design to view the suggested redesign shapes (you will use these later). 
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Review the Design Results data: 

 On the Results toolbar, click Design Results.  

 Click the Hot Rolled Steel tab to view AISC code check data; i.e., ratio of actual to allowable 

stresses. (Any failing members would be denoted with red text.) The allowable stresses, Cb and 

Cm values, and controlling equation are listed. If you were performing LRFD-based design, the 

member strengths would also be listed here (along with the code check value). 

 Click the Cold Formed Steel tab to view the cold formed steel code checks. The design strengths 

Pn and Mn are listed, along with the code check values and controlling equation. Factored 

design stresses and controlling equation are also listed.  

 Click the Wood tab to view the NDS code checks for your wood truss members members. The 

factored design stresses and controlling equation are also listed.  

 Click the Aluminum tab to view the aluminum code checks.   

 Concrete results are only available for Envelope solutions. To view the concrete results, solve 

the model for Envelope (Only) of Marked Combinations. Then click the Concrete Beams tab 

and the Concrete Columns tab to view the concrete code checks.   

Now, finish reviewing the Results toolbar data: 

 On the Results toolbar, click Material TakeOff to view the Material Takeoff spreadsheet. 

This spreadsheet shows material takeoff information for each material and shape in the model. For each 

material the shapes are listed with the total length and weight. The total length and weight for each 

material is summed beneath the listing of shapes.  

Graphic Results 

Since you have solved the model, you now have several more plotting options. But, you must first clean 

up your workspace a bit: 

 On the Window menu, select Single View. All the open spreadsheets will close.  

 Finally, on the Results toolbar, click Close   to close the toolbar. 
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Deflected Shapes 

Another important feature to help you quickly review your model is the ability to view deflected shapes. 

You will utilize this feature next. 

 On the Window toolbar, click Model Display Options  to open the Model Display Options 

dialog box. 

 Click the Deflection tab.  

 Under Show Deflected Shape For, click Load Combination (pick from list at bottom). The 

combination you solved will now appear in the list at the bottom. 

 Select the Include Undeflected Shadow check box. 

 Click OK.  

Your screen should now look like this: 

 

This is a simple representation of the model deflection under these loads. Next, you will use some of 

RISA-2D's more advanced graphics features. 

 On the Window menu, click Joint Labels  to turn off the joint labels.  

 On the Window toolbar, click Isometric  to display the model in isometric view. 

 On the Window toolbar, click Redraw  to display the full model view. 

 On the Window toolbar, click Rendering  twice.  
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As you can see, a rendered isometric view offers an excellent view of the model details. 

 

Animation 

Now, you can go a step further and animate this deflected shape plot. 

 On the Window toolbar, click Model Display Options   again. Make sure you are still on the 

Deflection tab. 

 Click the Animate This Deflected Shape button. 

A progress bar indicates that the animation is rendering, the speed of which will depend on the speed of 

your computer. Once your new animation displays, you can close the dialog box. 

 Click OK to close the dialog box. 

Note: You can change the speed of the animation using the Faster or Slower buttons. The deflected 

shape animation is a powerful tool that allows you to clearly see how the model is deflecting, and helps 

you identify parts of the structure that may have been incorrectly modeled or loaded. 

When you are finished watching the animation, close the window: 

 Click the Close button  to close the animation window.  
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Color-Coding Member Results 

Another important viewing tool is the ability to display members and highlight areas of concern. To 

demonstrate this, perform a plot of the model with each member color-coded by axial stress. 

 On the Window toolbar, click Model Display Options  to return to the Model Display 

Options dialog box. You should still be on the Deflection tab. 

 Click Don’t Show Deflected Shape to turn off the deflected shape.  

 Next, click the Members tab.  

 Under Draw Members As, select Color Coded. Under the Color Basis list, select Compression.  

 Click OK. 

Return to an elevation view to better see these color-coded results: 

 On the Window toolbar, click XY Planar .  

 On the Window toolbar, click Redraw .  

The color legend appears in the upper right side of the model view window. With the color-coded 

members, you can quickly identify members that require further attention.  

Display moments and reactions in the model view. 

 On the Window toolbar, click Model Display Options  again. You should still be in the 

Members tab. 

 Under Draw Members As, select Wireframe.  

 Under Member Results, in the Diagram list, select Moment. Ensure that Transparency is set to 

40%. Then, select the Magnitudes check box.  
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Modify the Joints settings: 

 Now, click the Joints tab.  

 In the Show the Reactions section, select the Y Direction check box. Then, select the Include the 

Magnitudes check box. 

 Click OK.  

The moment diagrams and reactions are now plotted with magnitudes, as shown below: 
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Member Detail Report 

Next, use the member detail report to take a closer look at some members. 

 On the Results menu, select Members - Member Detail.  

 Type M9, then click OK to display a report on member M9 

This report will display: 

 

Get even further detail on the deflection diagram: 

 Click the deflection diagram (the lower right diagram). 

 Then press the DOUBLE RIGHT ARROW  two times to display the deflection diagram for 

Member M11.  

  

Click any diagram for 

further detail. 

This detailed report displays all the 

forces, stresses, and deflections for 

any individual member. 
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The deflection diagram for member M11 will display:  

 

Besides the many ways to navigate these diagrams that are described above, you can also access 

diagrams for other values without returning to the model view or the detail report. 

 Click the list containing Deflection The entire list of available diagrams will display. Select Shear 

Force.  

The shear diagram for member M11 will display:  

 

Feel free to try any of the options or view another diagram from the list.  

 When you are finished, click the Close button to close any diagrams you may have open. 

  

Click to retrieve the absolute 

maximum value and its location.  

This slider allows you to retrieve values 

at approximately 100 section locations 

(based on the number of Internal 

Sections set in the Solution tab of 

Global Parameters). 
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You will be returned to the member detail report. 

 Scroll down in the detail report to view code check information: code check value along with the 

controlling equation and all of the design values.  

 Finally, click Close  to close the detail report. 

You may also open the member detail report by clicking on a member in the model view: 

 On the Selection toolbar, click the Detail button. The cursor will now change to . Click any 

member to generate a report for that member. Try clicking on a few members to see the various 

detail reports. 

You may also open detail reports from within any spreadsheet. 

 From the Results menu, select Members - Design Results. When the spreadsheet displays, click 

the Hot Rolled Steel tab. 

 On the Window toolbar, click Detail Report for Current Item. 

Printing Graphic Results 

First, return to the model view: 

 On the Window menu, select Single View to close the extra windows you may have open. 

 Click Joint Labels  to turn off the joint labels.  

Render the model, then print: 

 On the Window toolbar, click Model Display Options . Click the Members tab. 

 Under Draw Members As, select Rendered. 

 Click OK. 

 On the RISA toolbar, click Print . The Graphic Print Options dialog box will appear. 

 Click Landscape (paper orientation). 

 

 Click Continue. The Print dialog box will display. Select your printer, then click OK and the plot 

will be printed. 

This dialog box allows you to customize 

your printout by: scaling fonts and symbols 

for labels and legends, including the title 

bar, or adding any comments. 
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Tiling Results Windows 

RISA-2D provides some very useful window tiling options that will be explored next. 

 On the RISA toolbar, click the Tiling button. The Window Tiling Layouts dialog box will appear. 

Use the scroll bar to view the entire list of tiling options. Click Member Analysis Results. Click 

OK to accept your tiling selection.  

 On the RISA toolbar, click the Tiling button again. This time, select Three Results Views. This 

tiling option allows you to display three views at once. Click OK. 

Batch Solution 

The Batch solution option allows you to solve multiple combinations concurrently, storing the results for 

all. When using this option, the results for each will be recorded and can then be viewed in the results 

spreadsheets and organized either by load combination or by item. 

 On the RISA toolbar, click Solve again.  

 Select Batch Solution of Marked Combinations without Enveloped checkbox checked. Then, 

click Solve. A message will display notifying you that the results will be cleared. Select Yes. 

Note: Whenever you solve the model, RISA-2D will display a message notifying you that the results will 

be cleared (you may not want to purge results for a large model that took a fair amount of time to solve). 

If you would like to disable the warning message, go to the Tools menu, click Application Settings). 

With the Batch solution complete, you may now choose different load combinations when plotting 

results. Each view may show results from a different combination. 

 Click the lower left view to make it the active window.  

 On the Window toolbar, click Model Display Options . You should still be on the Members 

tab. 

 In the Combination to Use for Results Display list, select 8: IBC 16-1. Click OK. 

The lower left view now shows results for load combination 8. 

 On the Results menu, select Reactions to display them once again. 
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For the Batch solution, the spreadsheets display all results for each load combination. Currently, the 

results are grouped by combination. All reactions for Load Combination 1 are listed first, then for each 

combination thereafter. The combination number is listed in the first column.  

 

You can also group the results so that all the reactions for joint N1 are together, then WP1, etc. 

 On the Results menu, select Results Presentation - Batch Results Listed By Item to display them 

joint by joint. The first column shows the load combination. 

When performing a batch solution, you have the option to also include a set of envelope results. This is 

useful when an envelope result is desired to quickly determine a controlling load combination, but when 

the investigation of that load combination required the greater details given with batch solution results. 

When using the Batch + Envelope Solution, to view the envelope results, click on a spreadsheet in the 

Results toolbar. To view the batch results, click on that same spreadsheet in the Results toolbar a second 

time. Both the envelope and batch solution spreadsheets should now be available simultaneously. 

Envelope Solution 

An envelope solution differs from a single combination or a batch solution in that it only stores the 

maximum and minimum values. Each of the spreadsheets will contain minimum and maximum values 

for each load combination included. Because the rest of the data is not stored, the detail reports and the 

deflected shapes are not available when this solution type is selected.  

Return to the model view, then solve the model again, this time as an envelope solution:  

 On the Window menu, click Single View to return back to the model view. 

 On the RISA toolbar, click Solve .  

 Click Envelope of Marked Combinations, then click Solve. Click Yes to agree to clear the results. 

 Explore several of the spreadsheets to see how the results differ from the batch solution. 

Now, take a closer look at your concrete results.  

 On the Results menu choose Members - Design Results.  

 Click the Concrete Beams tab.  
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Take a moment to browse these beam results. This spreadsheet presents a maximum code check for the 

top reinforcing (negative bending), the bottom reinforcing (positive bending), and beam shear, along 

with the load combination that produced this maximum. In addition, the factored beam capacities are 

given for each critical location.  

 Next, click the Concrete Columns tab.  

The column design results are similar to the beam, except that the bending and shear results are given 

for biaxial loads.  

 On the Window toolbar, click the Detail Report for Current Item button. 

This will display an envelope detail report for the concrete column that looks like this: 

 

Because this detail report is based on moment and shear envelopes, it is somewhat different that the 

one you just reviewed for a steel member.  

 Scroll down to take a look at the interaction diagrams, span information, and reinforcing steel. 

In concrete design, each column or beam is divided into spans, depending on how many points of 

support it has. This portion of the detail report also contains information on the reinforcing steel 

required for each region of each span.  
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Code Check Results 

RISA-2D offers several ways to review the code check results. You can use a tiling option to organize 

your screen to include spreadsheet results as well as graphical model views showing the design data. 

Change the tiling options:  

 On the RISA toolbar, click Tiling. Select Member Steel Results, then click OK. 

Notice the red members in the model view indicate that you have members that are failing the code 

check. The worst case results are now being reported in the spreadsheet, as a result of the envelope 

solution you ran. The columns labeled LC report the load combination that generated the controlling 

values. Other results, such as the member forces, display maximum and minimum results in order to 

capture the worst of both negative and positive results.  

Optimizing Member Sizes 

The Suggested Design spreadsheet reports RISA-2D’s recommendations for alternate shape sizes, along 

with the member that is controlling the design.  

Note: If you are already using the optimum shape for a section set or member, it will not be listed on this 

spreadsheet. 

 On the Results toolbar, click the Suggested Design spreadsheet to make it active.  

The Suggested Design spreadsheet looks like this: 

 

Replace and re-solve with the suggested shapes: 

 On the Window toolbar, click Replace and Resolve . Then, click OK to agree to resolve. 

Now only a couple of members are in trouble. For this tutorial, you can simply ignore these last 

suggestions and move on. 
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Excluding Spreadsheet Results 

Next, you will use the Wood Code Checks spreadsheet to sort the members and hide the results for 

members that have a code check value lower than 0.6. This exemplifies how you can cut down the 

amount of data for review and verification in your spreadsheets, making it more manageable. 

 On the Window menu, click Single View to return back to the model view. 

 On the Results menu, click Members, then click Design Results.  

 Click the Wood tab. Drag the lower right corner of the window to enlarge it, so that you can 

view more of the results. 

Sort the results based on the maximum code check to reveal which members are closest to failure.  

 On the spreadsheet, click anywhere in the Code Check column.  

 On the Window toolbar, click Sort , then select Sort Max to Min, and click OK.  

Now, look for the last member with a code check value that is 1.0 or higher (which is in row  4). 

 Click any cell in row 4, moving the active cell anywhere on this row.  

The active cell is now in row 4, as shown below: 

 

Now, exclude (delete) all the results below row 4: 

 On the Window toolbar, click Exclude After . All rows below the active cell (rows 5 and 

below) will be deleted from the spreadsheet (keep in mind, you can always click Unexclude  

to retrieve them). 
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Printing Results and Spreadsheets 

Next, you will explore printing options for the spreadsheets. Because you have excluded some results 

from the spreadsheet, note that the excluded information will not print. 

 On the RISA toolbar, click Print to open the Data Printing dialog box.  

 

 Click Print Current Spreadsheet, and click OK.  

Once you select the printing option you prefer, the Print dialog box (for your printer) will display: 

 On the Print dialog box, select a printer, and click OK. The printer will then print your 

spreadsheet or report. 

Excluding Results Graphically 

You can also graphically select items you would like to print using the graphical exclude feature. 

 On the Window menu, select Single View.  

 On the Window toolbar, click Member Labels to display the member labels. 

 On the Selection toolbar, click Unselect All .  

Then, make your selection of the items you would like to print:  

 Click one concrete member, one steel member, one wood member, one cold formed steel 

member, one aluminum member, the wall panel, and two joints.  

  

Allows you to print selected lines in a 

spreadsheet (select the lines you would like 

printed, then click Print ). 

This option allows you to print an entire report 

of your input and/or output. 

Select this option to print a single spreadsheet. 
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Your screen should now look something like this: 

 

This next step will “exclude” the unselected items from the results: 

 On the Selection toolbar, click Exclude. Click Yes to exclude the results. 

Printing Reports 

You have excluded the unselected items from the results spreadsheets. Now it is time to print: 

 On the RISA toolbar, click Print .  

 Click Print a Report Instead. 

The Report Printing dialog box will display. As demonstrated below, you can select a standard report (by 

making a selection from the Report Name list) or you can build your own customized report (by making 

selections from all the available criteria). 

 In the Report Name list, select All Output. 

Notice that when you make this selection, items under Report Sections move from the Available Report 

Sections column to the Sections in Current Report column. Before you print, remove one more item 

from the report. 

 Under Report Sections, in the Sections in Current Report list, double-click Story Drift, X Service 

and Story Drift, X Strength. It will now move to the other column, and will not be printed. 
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The dialog box should now look like this: 

 

Print your customized report: 

 Click the Print button (at the bottom of the Report Printing dialog box). The Print dialog box (for 

your printer) will display. Click OK.  

 Click the Close button to close the Report Printing dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

This concludes all the tutorials for the RISA-2D User’s Guide. To gain further knowledge, you can go back 

and increase member sizes, solve different load combinations, or experiment with the plot in other 

ways. 

 On the File menu, click Exit.  

To move a section from one 

column to the other: highlight 

the section, and click the Add 

and Remove buttons.  

Shortcut: Double-click an item 

to move it from one column 

to the other. 

To adjust the printing order, 

use the Up and Down 

buttons. 
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Conclusion 

Congratulations on completing your introductory tour of RISA-2D! The time you invested in performing 

these tutorials is time well spent. We are confident that the knowledge gained by taking the time to step 

through these tutorials will increase your productivity, and allow you to complete future projects more 

quickly and efficiently. 

Some features available in RISA-2D, but not covered in this User’s Guide are listed below.  For more 

information about any of these features, refer to RISA-2D General Reference or the RISA-2D Help menu. 

Model Generation RISA-2D has a library of automatic generators that can quickly generate 

continuous beams, arcs, trusses, cylinders and numerous mesh layouts of 

your plate shell element. On the RISA toolbar, click Template  to access 

this feature.  

Moving Loads The standard AASHTO loads are built into the moving loads database and 

you can add custom moving loads as well. 

Thermal Loads You can model temperature differentials causing axial expansion or 

contraction of members. 

Dynamics You can run an eigenvalue solution to determine natural frequencies and 

mode shapes. You can run a Response Spectra analysis for earthquake 

loading.  

Tension-Compression-

Only Members and 

Springs 

These features allow you to model one-way stiffness such as braces that 

cannot take compression or soil that can only resist compression. 

Member Offsets You may rigidly offset the member ends to model rigid end zones and you 

may offset the tops of horizontal members to align member tops. 

Story Drift, Joint Slaving, 

and Enforced 

Displacements 

You may calculate and report inter-story drift, slave joints together or 

specify the displacement at a joint. 

Tapered Members and 

Unequal Flanges 

You may specify tapered wide flanges or members with unequal flanges 

and design them per the Appendix F criteria.  

 

If you have any questions or comments, please contact RISA Technologies by phone at (800) 332-7472, 

or email at info@risa.com.  
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Appendix A – RISA-2D Toolbar Button 

Quick Reference 

RISA Toolbar 

 

Button   Title   Label in RISA-2D   Shortcut 

 New Model  

Start a new model 

Start a new model (CTRL+N) 

 Open Model  

Open an existing model  

Reload from disk a 

previous model 

(CTRL + O) 

 Save  

Save current model to disk 

Save the current model 

data to disk 

(CTRL+S) 

 Copy  

Copy to the clipboard 

Copy to the clipboard (CTRL +C) 

 Print  

Print a report or graphic image 

Print a report or graphic 

image 

(CTRL +P) 

 Undo  

Undo the last operation 

Undo the last operation (CTRL +Z) 

 Redo  

Reverse the most recent undo 

operation 

Reverse the most recent 

undo operation 

(CTRL +Y) 

 Set (Global) Model Settings   Set (Global) Model 

Settings 

 

 Define Units  

Define units to be used 

Define units to be used  

 Shape Database  

Edit the shape database 

Edit the shape database  

 Moving Load Patterns  

View/edit the moving load 

patterns 

View/Edit the moving load 

patterns 

 

 Response Spectra Library  

Edit the response spectra library 

Edit the Response Spectra 

Library 
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 Rebar Layout  

Create and edit a custom rebar 

layout 

Create and edit a rebar 

layout 

 

 Template  

Perform High Level Generation 

Operations 

Perform high level 

generation operations 

 

 New Model View  

Create a new model view 

Create a new model view (CTRL+F2) 

 Open Spreadsheets  

Select spreadsheets to open 

Select spreadsheets to 

open 

 

 Refresh  

Refresh all windows with current 

data 

Refresh all open windows 

with the most current 

data 

 

 Basic Load Case  

Open the basic load case 

spreadsheet 

Basic Load Case (BLC) 

spreadsheet 

 

 Load Combinations  

Open the load combinations 

spreadsheet 

Load Combinations 

spreadsheet 

 

 Solve  

Perform the analysis and design 

calculations 

Perform the analysis and 

design calculations 

(F7) 

 Browse Results  

Select results to browse 

Select results to browse  

 Erase Results  

Erase all solution results 

Erase all solution results  

 Data Entry toolbar  

Turn the spreadsheet shortcuts 

menu on or off 

Turn the spreadsheet 

shortcuts window off or 

on 

 

 Results toolbar  

Turn the results shortcuts menu 

on or off 

Turn the results shortcuts 

window off or on 

 

 Help  

View Help topics 

View help topics (CTRL+F1) 

 Tiling Tile window options  
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Window Toolbar  

…in Model View   

 

Button  Title   Label in RISA-2D Shortcut 

 Model Display Options  Display Model Display Options (F2) 

 Rotate buttons 

 

Rotate the view counter-

clockwise about the X axis 

 

  Rotate the view clockwise 

about the X axis 

 

  Rotate the view counter-

clockwise about the Y axis 

 

  Rotate the view clockwise 

about the Y axis 

 

  Rotate the view counter-

clockwise about the Z axis 

 

  Rotate the view clockwise 

about the Z axis 

 

 View buttons  

 

  

 Isometric  

Display an isometric view 

Snap to an Isometric view  

 XY Planar  

Display an XY planar view 

Snap to an XY planar view  

 XZ Planar  

Display an XZ planar view 

Snap to an XZ planar view  

 YZ Planar  

Display a YZ planar view 

Snap to an YZ planar view  

 Zoom buttons  

 

  

 Zoom In  Zoom IN (closer view) on the 

model (+) 

PLUS (+) 

 Zoom Out  Zoom OUT (view farther away) 

on the model (-) 

MINUS (-) 

 Box Zoom  Draw a box around the part of 

the model to be zoomed 
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 Redraw  

Redraw full model view 

Redraw full model view  

 Graphic Editing  

Activate the Graphic Editing 

toolbar (also known as Drawing 

toolbar) 

Activate the Graphic Editing  

(Drawing) toolbar 

(CTRL +G) 

 Save or Recall View  

Save or recall view states 

Save or recall view states  

 Clone View  

Make an exact copy of current 

model view 

Clone (make an exact copy of) 

the current model view 

 

 Loads Display buttons 

 

  

 Display Loads  

Toggle display of the loads  

Toggle display of the loads (LC 

or CAT) 

 

 Loads List – lists the available 

loads  

Select your load display from 

this list 

 

 Switch Loads  

Switch loads display  

Switch load display   

 Rendering  

Toggle between wireframe and 

rendering of beams and plates 

Toggle between wireframe 

and rendering of beams and 

plates 

 

 Joint Labels  

Joint labels toggle 

Toggle the joint labels  

  Member Labels  

Member labels toggle 

Toggle the member labels  

 I End-J End  

Toggle display of member I end, J 

end representation 

Toggle display of member I 

End, J ends 

 

 Boundary Conditions  

Toggle display of the boundary 

conditions 

Toggle display of the 

boundary conditions 

 

 Global Axes  

Toggle the global axes icon 

Toggle the global axes icon  
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Window Toolbar  

…in Spreadsheet View 

 

Button   Title   Label in RISA-2D Shortcut 

 New Line  

Insert a new line before the 

current line  

Insert a new line before the 

current line  

(F3) 

 Delete Line  

Delete the current line  

Delete the current line  (F4) 

 Repeat Line  

Repeat the current line  

Repeat the current line  (F8) 

 Fill  

Fill the currently marked 

block  

Fill the currently marked 

block of cells 

(CTRL+F) 

 Math  

Perform math on the 

currently marked block  

Perform math on the 

currently marked block  

(CTRL+M) 

 Mark Lines  

Mark all the lines 

Mark all the selected lines  

 Delete Lines  

Delete the currently marked 

lines  

Delete the currently marked 

lines  

(CTRL+D) 

 Unmark Lines  

Unmark all the lines 

UNmark all the lines  (CTRL+L) 

 Select Marked Lines  

Select all marked lines 

Select all marked lines  

 Unselect Marked Lines  

Unselect all marked lines 

Unselect all marked lines  

 Paste  

Paste from the clipboard  

Paste from the clipboard  (CTRL+V) 

 Help  

Help on the current window  

Help for the current 

window  

(SHIFT+F1) 
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These additional buttons appear after results are generated: 

 Replace and Resolve  

Replace current shapes and 

then solve again 

(Only available while in the 

Suggested Shapes 

spreadsheet) 

Replace current shapes and 

then re-solves 

 

 Exclude After  

Exclude all results after the 

current item 

(Available in most Results 

spreadsheets) 

Exclude all results after the 

current item 

 

 Unexclude  

Un-Exclude all previously 

excluded results 

(Available in most Results 

spreadsheets) 

Un-exclude all previously 

excluded results 

 

 Sort   

Sort based on the values in 

the current column 

(Available in most Results 

spreadsheets) 

Sort based on the values in 

the current column 

F9 
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Drawing Toolbar 

 

Button   Title   Label in RISA-2D Shortcut 

 Draw New Members  Draw new members  

 Draw New Plates  Draw new plates  

 Draw New Wall Panels  Draw new wall panels  

 Modify Boundary Conditions  Modify boundary conditions  

 Joint Loads or Moments  

Apply joint loads or moments to 

joints 

Apply joint loads or moments 

to joints 

 

 Distributed Loads  

Apply distributed loads to members 

Apply distributed loads to 

members 

 

 Point Loads or Moments  

Apply point loads or moments to 

members 

Apply point loads or 

moments to members 

 

 Moving Point Loads  

Apply moving point load to member 

Apply moving point load to 

member 

 

 Linear Translation Move  

Move via linear translation the 

currently selected part 

Move via linear translation 

the currently selected part of 

the model 

 

 Rotational Move  

Move via rotation the currently 

selected part 

Move via rotation the 

currently selected part of the 

model 

 

 Scale Factor Move  

Move via a scaling factor the 

locations for the currently selected 

joints. 

Move via a scaling factor the 

locations for the currently 

selected joints 

 

 Linear Offset Copy  

Copy the currently selected part 

using linear offsets 

Make copies of the currently 

selected part of the model 

using linear offsets 

 

 Rotational Offset Copy  

Copy the currently selected part 

using rotational offset 

Make copies of the currently 

selected part of the model 

using rotational offset 
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 Mirror Image Copy  

Mirror image copy of the selected 

part 

Make a mirror image copy of 

the currently selected part of 

the model 

 

 Model Merge  

Perform a model merge on all or 

part of the model 

Perform a model merge on 

all or part of the model 

 

 Trim  

Trim the member 

Trim the member  

 Extend  

Extend the member 

 

Extend the member  

 Delete  

Delete parts of the model 

Delete parts of the model  

 Modify Drawing Grid  

Modify the drawing grid and snap 

points 

Modify the drawing grid and 

snap points 

 

 Drawing Grid  

Toggle the drawing grid on or off 

Toggle the drawing grid on or 

off 

 

 Universal Snap Points  

Toggle the universal snap points on 

or off 

Toggle the universal snap 

points on or off 
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Selection Toolbar 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Button   Title   Label in RISA-2D Shortcut 

 Select All  

Select the entire model 

Make the entire model 

selected  

CTRL+A 

 Box Select  

Draw a box around the part to 

be selected 

Draw a box around the 

part of the model to be 

selected 

 

 Polygon Select  

Draw a polygon around the part 

to be selected (double click to 

end) 

Draw a polygon around 

the part to be selected 

(double click to end) 

 

 Line Select  

Draw a line through the beams 

and plates to be selected 

Draw a line through the 

beams and plates to be 

selected 

 

 Unselect All  

Unselect the entire model 

Make the entire model 

UNselected  

CTRL+U 

 Box Unselect  

Draw a box around the part to 

be unselected 

Draw a box around the 

part of the model to be 

UNselected 

 

 Polygon Unselect  

Draw a polygon around the part 

to be unselected (double click 

to end) 

Draw a polygon around 

the part to be UNselected 

(double click to end) 

 

 Line Unselect  

Draw a line through the beams 

and plates to be unselected 

Draw a line through the 

beams and plates to be 

UNselected 

 

 Invert Selected  

Invert the selected areas of the 

model 

Invert the selected state 

of the model  

CTRL+I 

 Criteria Selection  

Select or unselect  

Select or Unselect based 

on other criteria 

 

 Save/Recall Selection  

Save or recall selections of the 

model 

Save or Recall Selection 

States for the Model 

 

 Lock Unselected 

Lock the unselected parts of the 

model 

Lock the unselected part 

of the model 

CTRL+L 


